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Via Afrika understands, values and supports your role as a teacher. You have the most important job in education, and we 
realise that your responsibilities involve far more than just teaching. We have done our utmost to save you time and make 
your life easier, and we are very proud to be able to help you teach this subject successfully. Here are just some of the things 
we have done to assist you in this brand-new course:

1. The series was written to be aligned with CAPS. See page 16 to see how CAPS requirements are met.
2. A possible work schedule has been included. See page 16–23 to see how much time this could save you.
3. Each topic starts with an overview of what is taught, and the resources you need. See page 26 to find out how this will

help with your planning.
4. There is advice on pace-setting to assist you in completing all the work for the year on time. Page 87 shows you how this

is done.
5. Advice on how to introduce concepts and scaffold learning is given for every topic. See page 102 for an example.
6. All the answers have been given to save you time doing the exercises yourself. See page 142 for an example.
7. Also included is a CD filled with resources to assist you in your teaching and assessment. See the inside front cover.
8. A question bank with tests you may photocopy will help you assess your learners effectively. See the Question Bank on

page 209.

The accompanying Learner’s Book is written in accessible language and contains all the content your learners need to master. 
The exciting design and layout will keep their interest and make teaching a pleasure for you.

We would love to hear your feedback. Why not tell us how it’s going by emailing us at 
computerapplicationstechnology@viaafrika.com? Alternatively, visit our teacher forum at www.viaafrika.com.

www.viaafrika.com

— Bandile Bavuma, Teacher
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This is the best Grade 12 Computer Applications Technology study guide 

you will ever have! 

Here are some tips to make this a good year. 

Remember, good learning begins in the classroom! 

Always: 

 listen and concentrate
 observe: watch carefully what is happening
 make notes to help you remember what you are learning
 ask questions to make sure you understand.

Study tips 

 Allocate one hour every week-night as study time in addition to your homework.
 Decide when your main study time should be. Some learners study better in the early

morning, some study better in the evening.
 Keep to your timetable.
 Study time is a priority – it is one of the most important things in your life at school.
 Find a quiet place to study. (Try a quiet classroom at school or the local library if

possible.)
 Choose study partners who are serious about doing well to work with you.

7 golden rules for success 

1  Always do your homework. 
2  Do not fall behind. 
3  Study every day. 
4  Eat healthy food and sleep at least eight hours each night. 
5  Make sure you understand as you go along. 
6  Do it now! 
7  Do not give up: learning gets easier and faster when you practise. 

Good luck! 

The authors
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Chapter 1 Systems Technologies 

Overview 

It is important for you to revise the hardware and software concepts that you learnt in Grades 
10 and 11. In this chapter, you will learn about: general concepts of computing; hardware 
input and output devices; hardware storage devices and processing procedures; software and 
software management; and computer management. 

Unit 1 (General concepts) reinforces the information processing cycle, types of computers 
and their typical features. Different computer categories and the reasons for using computers 
as well as the convergence of technology is investigated. 

Unit 2 (Hardware) is about make buying decisions and how to fix ordinary computer-related 
problems. You will investigate and reinforce new technologies and social implications. 

Unit 3 (Software) covers software that enhances accessibility, efficiency and productivity, and 
the use of common applications software. You are required to interpret system requirements 
and choose software for a specific situation. We also cover the risks of using flawed software 
and user-centred design. 

Unit 4 (System software and computer management) covers the role of the operating system 
within a computer and investigates the factors that influence the speed of a computer. 
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Unit 1 General concepts (Term 1) 

1 Types of computer systems for different users 

Computer systems are designed to satisfy the needs of different types of users. 
 
1.1 Personal computer 

 Personal computers (PCs) are designed to perform a wide range of tasks for a single user. 
 Are usually cheaper than other computer systems. 
 Has the basic input and output devices such as a monitor, keyboard and a mouse. 

 
1.2 SOHO user 

 The single office/home office (SOHO) uses a collection of computing devices such as 
printers, computers and scanners connected together in a small area such as an office. 

 Can be used for a small business or personal network at home. 
 

1.3 Mobile user 

 Mobile computer systems are designed to be transported easily and used whilst on the 
move. 

 Includes PDAs, laptops, tablets and smartphones. 
 

1.4 Power user 

 Power users use faster and more expensive than personal computers. 
 More RAM, faster CPU and more storage space. 
 Higher specifications needed for applications that use more resources, such as that used by 

gamers or photographers. 
 

1.5 Enterprise user 

 Companies (enterprises) that have hundreds or thousands of users across the country or 
world. 

 Each user on a large network is an enterprise user. 
 

2 Role and use of data, information, knowledge and 

conclusions 

 Data is a collection of raw facts that are not organised in a meaningful format.  
 Information is the meaningful knowledge obtained after processing the data. 

 

3 Reasons for using computers 

3.1 Saving paper, time and labour 

 Paper can be saved by compiling, using and sending data electronically. 
 Electronic documents are faster to create than writing them out by hand, and electronic 

documents can be sent faster via e-mail than by the normal postal service. 
 Repetitive jobs that require low skills can be done by computers instead of humans. 
 Computers can perform complex mathematical calculations easier and faster than humans. 
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3.2 Communication costs 

 E-mail, VoIP and instant messaging are cheaper than conventional communication 
methods such as phone calls. 

 Communication is not free, as an Internet connection is still needed. 
 

3.3 Efficiency, accuracy and reliability 

 Computers allow users to enter data efficiently by ensuring accuracy. 
 Garbage in garbage out (GIGO) means inaccurate input will result in inaccurate output. 

 
3.4 Effect on distance and time 

 Communication can occur irrespective of distance. 
 Communication costs the same irrespective of distance. 
 Instant communication of documents is possible. 

 
3.5 Global communication using social networks and web tools 

 Social networks allow people from around the world to interact socially irrespective of 
time and distance. 

 Web tools are functions and features on the Internet to help users: for example blogs and 
wikis. 

 A blog is an online form of a diary. 
 A wiki is a website that allows users to use their web browsers to create, edit or remove a 

particular website’s content. 
 Real simple syndication (RSS) compiles updates from multiple sources such as blogs to 

one central place which could be an application or a website. Users do not have to visit 
separate blogs, but can find all new news in one place. 

 Web 2.0 refers to social websites that allows users to interact socially by sharing personal 
information. 
 

4 Convergence of technology 

 Convergence is the trend where manufacturers offer devices in which technologies 
overlap. 

 Example of convergence is a smartphone which is a device used to make calls, take digital 
pictures, take digital video, browse the Internet and act as a GPS receiver or navigator. 

 Other examples of the convergence of technology are modern television sets which allow 
users to browse the Internet. 
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Unit 2 Hardware (Term 1) 

1 Information processing cycle 

 The information processing cycle consists of input, processing, output and storage. 
 Input is data being entered into a computing device using an input device. 
 Processing is when data is being translated into something useful by the CPU and RAM. 
 Output is when information is presented to the user after processing. 
 Information and data can be stored for future use. 
 Computers can communicate data and information using a communication network. 

 

2 Integration of input modes to enhance productivity 

 Separate devices using different input modes can be used together to input data 
productively. 

 If one input mode fails another can be used: for example, a cashier entering barcode 
manually when a scanner malfunctions. 

 Integrating input modes for security makes it more difficult for criminals to gain access to 
a secure system. 

 QR codes (Quick Response codes) make use of a camera and OCR (Optical Character 
Recognition) technology to translate QR code to a series of characters. 
 

3 Making buying decisions 

Knowledge regarding devices will allow users to make enlightened decisions regarding which 
device will suit a specific purpose. 
 
3.1 Keyboard and mouse 

The keyboard and mouse are the main input devices on computers that are used for extended 
periods of time. 
 
3.1.1 Ergonomic considerations 

The shape of the device and location of the buttons will influence the ergonomic functionality 
of a device. 

 

Ergonomic considerations for keyboard and mouse 

Keyboard Mouse 

Wrist rests help to keep wrists straight 
while typing. 

A mouse pad that includes a wrist rest and which 
supports the wrist. 

Split key or curved keyboards allow a 
user to have his or her hands on the 
keyboard at a more natural angle. 

The shape of the mouse influences how 
comfortable it is to use. 

The keyboard should be at a comfortable 
height for the user. 

Keys should be easy to click. 
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Ergonomic considerations for keyboard and mouse 

Lowering the keyboard and bringing it 
closer to the body using a keyboard tray 
can also help reduce stress on the wrists, 
shoulders and back. 

The mouse should move easily. 

 
3.1.2 Wireless and cabled hardware 

 

Comparison of cabled and wireless hardware 

Wireless Cabled 

Can operate from a distance, without cables 
getting in the way. 

Cannot be used further away from the computer 
than the length of the cable. 

Needs a separate power source, such as 
batteries. 

Receives power from the computer through the 
cables. 

Can be used in situations where cables are not 
practical. 

 

 

3.2 Digital cameras and webcams 

Digital cameras are able to capture or record live images using a sensor and store the data 
digitally on a memory card. 
 

Advantages and disadvantages of digital cameras 

Advantages Disadvantages 

Image can be seen immediately on the camera 
screen. Those you do not want can be deleted. 

The initial cost of buying a digital camera can be 
expensive. 

Images can be downloaded to your computer and 
edited or sent electronically. 

Moisture may cause a problem because of the 
electronic circuits in a digital camera. 

You print only the images you want.  

A memory card is able to hold a large amount of 
images, depending on the storage space. 
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Advantages and disadvantages of digital cameras 

A memory card can be erased and reused.  

Most digital cameras can also record digital 
video. 

 

 
Webcams are digital cameras that take low resolution pictures or videos intended for 
transmission over a network such as the Internet. 
 

Advantages and disadvantages of webcams 

Advantages Disadvantages 

Webcams are relatively cheap to buy. Images and videos from webcams have a low 
resolution. 

Because images and videos from webcams have 
a low-resolution, they can be transmitted over the 
Internet. 

Poor or slow Internet connections can result in 
poor video quality. 

Webcams allows video communication from 
anywhere in the world where an Internet 
connection is available. 

 

Non-verbal cues such as facial expressions can 
be seen during a video call or video conference. 

 

 

3.3 Scanners and monitors 

Scanners use light to convert images or documents from hard copies to soft copies as 
electronic files on your computer. 
 
3.3.1 Resolution and image quality 

 Resolution describes the image quality measured by the amount of pixels displayed in 
horizontal and vertical lines. 

 Colour depth indicates the amount of colours that can be shown. 
 Higher image quality will depend on a high resolution and colour depth. 
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3.3.2 OCR 

 Optical character recognition (OCR) translates a scanned document to editable text. 
 Scan needs to be of a good quality for OCR to work. 
 

Advantages and disadvantages of scanners 

Advantages Disadvantages 

Images transferred to a computer can be  
e-mailed or used as input to another application. 

High-quality scanned images use large amounts 
of disk storage space. 

A scanner can be used together with a printer to 
make copies of documents or images. 

A scanner needs to be of a high quality to 
produce a good quality image. 

 
3.4 Voice recognition 

 The ability of a computing device to recognise and distinguish between spoken words. 
 Can be used to give voice commands such as dialling a phone number or type out the 

words a user is saying. 
 

Advantages and disadvantages of voice recognition 

Advantages Disadvantages 

Speech is a more natural input method than using 
a keyboard or mouse. 

Background noise can influence the accuracy of 
any voice recognition. 

The technology is relatively cheap as no special 
hardware is needed. 

A voice can be recorded easily and played back, 
making the method unsafe for passwords. 

 A cold may affect the user’s voice and make 
voice recognition impossible. 

 
3.5 Printers 

 Used to transfer text and images contained in electronic files to paper (hard copy). 
 Printer types include laser and inkjet printers. 

 
3.5.1 Which printer will suit your needs? 

 Be aware of the following requirements when deciding on a printer: 

 Budget: Entry level A4 printers are much cheaper than photo quality A3 printers. 
 Printer speed: Laser printers are much faster than inkjet printers. 
 Colour: Some printers will not be able to print in colour. 
 Cost per page: Laser printers are usually cheaper per page than inkjet printers. 
 Graphics capability: Inkjet printers produce better quality graphics. 
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 Photo printing: For photos a high-quality photo printer is needed. 
 Paper sizes and paper type: Common size is A4 although larger or smaller sizes are 

available as well as specialist printers such as label printers. 
 System compatibility: Newer printers may not be compatible with older computer 

systems. Be sure to check that a port on the computer and drivers are available. 
 Wireless capability: Wireless printers may be ideal when cables cannot be used. 
 Mobility: Printers are available that have been designed to be mobile to be used in 

conjunction with a mobile device such as a printer. 
 

3.5.2 Resolution 

 Printer resolution refers to the amount of ink droplets in a line of 1 inch (2.54 cm) long. 
 The resolution will influence the use: for example you will not use a low resolution printer 

for printing photos. 
 

3.5.3 Economic and environmental considerations 

 Laser printers tend to produce more prints per cartridge resulting in a printer that is 
cheaper to run. 

 When disposing of used cartridges do so responsibly by: 
 Returning the cartridge to a company that will dispose of it. 
 Refilling and re-using the cartridge. 
 Not throwing cartridges in the rubbish bin as the contents may be toxic. 

 
3.6 Storage 

Data storage on a computer enables a user to save instructions for future use. 
 

3.6.1 Capacity 

 The amount of data that can be stored. 
 Storage capacity is measure in bits and bytes. A byte is a group of 8 bits. 

 8 bits = 1 byte 
 1024 bytes = 1 kilobyte (kb) 
 1024 kilobyte = 1 megabyte (MB) 
 1024 megabytes = 1 gigabyte (GB) 
 1024 gigabytes = 1 terabyte (TB) 

 
3.6.2 Volatility 

 Volatile memory loses its content when electricity to the device is cut off. 
 Non-volatile memory keeps contents even without electricity. 

 

3.6.3 Durability 

 Durability refers to how long data on a storage device will be viable. 
 Storage devices should be handled with care: for example do not place a magnet near a 

hard drive and ensure that DVDs and CDs are not scratched. 
 

3.6.4 Backups 

 A backup is a copy of data, files or programs stored on a separate storage medium or 
device which is usually in a different geographical location (off-site). 
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 If the original data gets lost or is corrupted then data can be restored from the backup. 
 

3.6.5 Cloud storage 

 Cloud storage enables users to store data on servers around the world using the Internet to 
transfer data. 

 

Advantages and disadvantages of cloud storage 

Advantages Disadvantages 

Storage space is free of charge in most 
Cases, but you still need to pay for your Internet 
connection. 

Users struggle to retrieve data over slow Internet 
connections. 

Users can retrieve data from anywhere in 
the world where an Internet connection is 
available. 

Users never know if the data in the cloud 
is totally secure. 

Users do not have to carry any removable 
storage or mobile devices around with them in 
order to access their data. 

Users cannot retrieve data or use it in any 
way, if the Internet connection is unavailable.. 

 

3.7 Processing 

 The CPU and RAM work together to process data into information. 
 The RAM temporarily stores the data the CPU is working on. 
 The CPU does all of the calculations. 

 
3.7.1 Making informed decisions regarding CPUs and RAM 

 CPU speed is measured in gigahertz (GHz). 
 Be sure to check the specifications needed by applications before purchasing a CPU. 
 Buy a CPU that is faster than your needs so that it will be fast enough for longer. 
 Determine the amount of RAM needed. 
 Be sure to buy the correct model or size of CPU and RAM to fit your motherboard. 

 
3.7.2 Interpret specifications 

 Interpret advertisements by identifying specific components such as the CPU and RAM. 
 Find these specifications by searching for the speed, manufacturer or amount. 

 
3.8 Productivity, efficiency, accuracy and accessibility issues 

 Computers are capable of doing more work than a human. 
 Accuracy can be controlled and improved by using features such as data validation and 

input masks. 
 Users with disabilities can perform functions using computers which they otherwise could 

not have done. 
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3.9 Risks associated with input devices 

 Carpal Tunnel Syndrome (CTS) is an example of Repetitive Strain Injury (RSI). 
 CTS is inflammation of the joints caused by continuous repetitive motion. 
 Keyloggers record every keystroke on a keyboard. 
 Keylogging can be used by: 

o Computer hackers may install keyloggers in an attempt to steal usernames, 
passwords and pin numbers, for illegal purposes 

3.10 Specifications for processing, input, output, storage and 

communication devices 

Each user has a specific unique situation for which a computer can be used. 
 

3.10.1 Specifications for home user 

For basic tasks such as word processing and browsing the Internet. 
 

Specifications for the home user 

Input Output Storage Communication Processing 

Keyboard 
Mouse 

Monitor 
Printer 
Speakers 

Hard drive 
CD or DVD drive 

Modem or router Entry-level CPU 
and minimum 
amount of RAM. 

 
3.10.2 Specifications for SOHO user 

 Devices need to be connected together in a small area such as a house or office. 
 Devices are used for more intense purposes than personal computers. 
 

Specifications for the SOHO user 

Input Output Storage Communication Processing 

Keyboard 
Mouse 
Multifunction 
printer and 
scanner 

Monitor 
Speakers 

Hard drive 
CD or DVD drive 
Flash Drive 
 

Modem or router Higher speed CPU 
and more RAM 
than a personal 
computer. 

 

3.10.3 Specifications for mobile user 

 A mobile user must be able to transport devices easily and use little electricity.  
 Usually will involve the use of a laptop, netbook or tablet. 
 

Specifications for the mobile user 

Input Output Storage Communication Processing 
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Specifications for the mobile user 

Integrated 
keyboard and 
touchpad 
Mobile scanner 

Integrated 
monitor and 
speakers 
Mobile printer 

Hard drive 
CD or DVD drive 
Flash drive 

3G connection Mobile entry-level 
CPU and minimum 
amount of RAM. 

 

3.10.4 Specifications for power user 

Use computers for tasks where high processing power and large storage space is needed. 
 

Specifications for the power user 

Input Output Storage Communication Processing 

Keyboard 
Mouse 
Scanner 

Large monitor 
High quality 
printer 
Speakers 

Hard drive 
CD or DVD drive 
Flash drive 

Modem or router High-end CPU and 
large amount of 
RAM. 

 

3.10.5 Specifications for disabled user 

Special devices may be needed to allow a disabled person to use a computer. 
 

Specifications for the disabled user 

Input Output Storage Communication Processing 

Alternative 
keyboard 
Pointing stick/ 
Joystick 

Large monitor 
Printer 
Speakers 

Hard drive 
CD or DVD drive 
Flash drive 

Modem or router Ranges from entry-
level to high-end 
CPU and varying 
amount of RAM 
depending on the 
situation. 

 

4 Consolidating and reinforcing knowledge 

It is important for you to refer to your Grade 10 and 11 CAT work and revise and consolidate 
hardware and software – including advantages, disadvantages, limitations and uses of input 
devices, output devices, storage devices and communication devices.  
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5 Fix ordinary problems 

Understand and fix common problems yourself, without paying a technician, in the following 
ways. 
 
5.1 Application not responding 

 Applications may stop responding to user input due to: 
 Hardware malfunction 
 Not enough RAM to perform function 
 Virus infection 
 Incorrect configuration 
 Thrashing (see explanation below). 

 Virtual memory uses hard drive space as RAM. 
 Data is saved in a swap file from where it is swapped to and from the RAM as needed. 
 Thrashing describes the situation of swapping becoming so rapid the application stops 

responding. 
 

5.2 Sticky mouse 

 Mouse will stick when dirt clogs the light or it is placed on a reflective surface. 
 To fix the problem remove the dirt or place the mouse on a mouse pad. 
 

5.3 Scanning 

 

Scanning problems and solutions 

Problem Solution 

The edges of the document or picture did not get 
scanned. 

Reposition the document or picture, as it was not 
aligned correctly on the scanner. 

The colours in the document look wrong. Make sure to select the correct colour profile. For 
example, do not use monochrome or greyscale if 
you want to scan a colour picture. 

The OCR application cannot recognise any text in 
the scanned document. 

Make sure that the document is clear, and 
increase the scanning resolution. 

The resulting file from a scan is too large. Decrease the dpi or resolution setting of the scan. 
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5.4 Resolution 

 The number of pixels used to create an image on the screen or a printout. 
 If the resolution of a monitor was set too high, wait for 15 seconds and it will revert to its 

previous setting. 
 A low resolution will result in everything on the screen being extremely big. 

 
5.5 Printing problems 

 

Printing problems and solutions 

Problem Solution 

Printer does not switch on . Check the connection of the power cable. 

Is the power outlet switched on? 

Is the power outlet being supplied with power? 

Paper jams Remove the paper jammed in the printer. 

Printer is not available Install the printer on your computer 

The wrong printer driver has been installed 

Check the USB connection of your printer 

Network printer does not print Install the printer correctly 

Check the connections to the printer 

Printer does not print Check to see of the toner/cartridge is empty. 

 
5.6 Disk errors 

 Fragmentation is when parts of a file (clusters) are not located together physically on the 
disk but scattered all over the hard drive.  

 Fragmentation slows down your computer as all the clusters must first be collected and 
combined before the file can be used. 

 Defragmentation is the process where clusters are rewritten to be in sequential clusters on 
the disk. 

 Defragmentation does not open up extra storage space. 
 

5.7 Closing non-responding programs 

 Access the Task Manager by pressing Ctrl, Alt and Del together, then select Start Task 
Manager. 

 Select the application that is not responding and click on End Task. 
 

5.8 Checking free space on storage devices 

 Open My Computer 
 Right click on the relevant storage device and select Properties. 
 The dialog box will display all the information regarding storage space. 
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6 New technologies 

 Solid State Drives (SSD) are hard drives that do not have any moving parts. 
 SSD drives are expensive but very fast. 
 Raspberry Pi is a cheap, extremely small computer designed for educational purposes. 

 

7 Social implications: environmental issues 

7.1 Printing 

 Use printers in environmentally friendly way by ensuring the following: 
 Print on both sides of the paper. 
 Use recycled paper. 
 Send used paper to be recycled. 
 Print two pages of information on one page of paper. 
 Avoid printing at all if possible. 
 Print in draft mode to reduce ink use. 
 

7.2 Monitors 

 Use LED or LCD monitors because: 
 They use less electricity. 
 They contain fewer toxic chemicals than older monitors. 

  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 15 

Unit 3 Software (Term 1) 

1 Software that enhances accessibility, efficiency 

and productivity 

1.1 Voice recognition 

 Voice recognition allows a computer to recognise the spoken word. 
 Voice recognition can be used so that: 

 Computers respond in certain ways for disabled users. 
 Documents can be typed while a user speaks, which will then allow the user to use his 

hands for another purpose such as voice dialling on a smart phone. 
 A transcriber can transcribe directly into an electronic document. 

 
1.2 Typing tutors/keyboarding skills 

Typing tutors are programs that improve the speed and accuracy with which a user can type by 
enabling the user to take part in keyboard 'games'. 

 
1.3 Note-taking software 

 Note-taking software allows users to make notes just as they would in a physical paper 
notebook. 

 Software then converts these handwritten notes to a form of video, digital handwriting and 
pictures. 
 

2 Use of common application software 

2.1 Practical applications 

 

Applications used for common tasks 

Application Common tasks 

Word processing application Writing a letter; setting a fax 

Spreadsheet Creating an invoice that calculates amounts 
automatically 

Database Collecting related facts, which can then be 
presented in an orderly fashion 

Presentation Creating a slide show 

 

2.2 Reference software 

Reference software is used instead of printed versions of an encyclopaedia, thesaurus, atlas or 
dictionary. 
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Types of reference software 

Reference type Software examples 

Encyclopaedia Wikipedia®, Britannica 

Dictionary Babylon, MasterWriter, Cambridge dictionary 

Atlas Google Earth 

Thesaurus Thesaurus.com 

Translation dictionary English to Xhosa and Google Translate 

 
2.3 E-mail software 

Also called an e-mail client application 
 

Common e-mail functions 

Major functions of an e-mail client Examples of e-mail clients 

Retrieving e-mail  Windows Live Mail 
 Mozilla Thunderbird 
 Microsoft Outlook 

Composing and sending e-mail 

Storing sent and received e-mail 

Searching through e-mail 

 
2.4 Document management software 

An application or set of applications used to store and manage a collection of electronic 
documents is called document management software. 
 

Common document management software functions 

Function Description 

Storage Stores documents in an orderly fashion 

Index Keeps an index or list of documents for easy reference 

Retrieval Finds and opens documents 

Security Stops users accessing one another’s work and illegal access from outside 

Publishing Allows the user to output data to hard copy, or a different file format 
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Common document management software functions 

Workflow 
management 

Helps a user keep track of what has been done, and what needs to be done 
(that is, the workflow) 

 

2.5 Web browsers 

 A web browser is an application used to view a web page. 
 Examples of web browsers include Microsoft Internet Explorer, Mozilla Firefox and 

Google Chrome. 
 

3 Web-based and installed applications 

 Applications that can be accessed on your computer without the need to insert a removable 
device such as a CD are called installed applications. 

 Web-based applications are stored on servers and accessed via the Internet or an Intranet. 
 Examples of web-based applications are Google Docs, Skydrive and Dropbox. 
 Functions include: 

 Basic office applications such as word processors and spreadsheets 
 Online file storage 
 Navigation using online maps 
 Basic photo editing. 

 

Advantages and disadvantages of web-based applications 

Advantages Disadvantages 

The user does not need to install the software. The user’s web browser needs to be compatible 
with (able to work with) the application. 

In large organisations, all the computers with a 
web browser can access the application without 
any individual installations being needed. 

If the user cannot connect to the Internet, he or 
she cannot access the application or the saved 
data. 

The application does not take up any storage 
space on your computer. 

The interfaces of web-based applications are 
usually not as highly developed as those on 
installed applications. 

The user does not need to update the application 
on his or her computer because it will be updated 
on the server where the application is hosted. 

There is a security risk linked to web-based 
applications. Users are not always sure that the 
data on the servers is safe. 

Web-based applications are independent of the 
operating system, and can be accessed from any 
computer. 

In most cases, the application is much slower 
than an installed application. 
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Advantages and disadvantages of web-based applications 

Users can access their applications and data 
from any computer connected to the Internet. 

 

In many cases using the application is free.  

 
 

Advantages and disadvantages of installed applications 

Advantages Disadvantages 

The application offers the user more functions. The user must install the software before using it. 

The user can use the application without being 
connected to the Internet. 

The user installs the software on one computer 
and he or she can access it on only that 
computer. 

 Applications take up storage space on the user’s 
computer. 

 

4 Interpret system requirements 

 System requirements: these describe the hardware and software needed to make an 
application work. 

 Minimum system requirements: the lowest possible specifications for the application to 
work at all. 

 Recommended system requirements: the specifications that will make the application work 
at its full potential. 
 

5 Common software problems and upgrades 

 Errors can be made during the development of software. 
 Criminals may make use of these errors for illegal purposes or certain features on the 

software may not work as expected. 
 

5.1 Obtaining and installing software improvements 

 Updates to fix errors are released by software developers in the form of patches. 
 Patches are small pieces of programming code that fix problems. 
 Patches are periodically grouped together in one installation and released as service packs. 

 
5.2 Read-only files 

 Read-only files allow users to open and read the file, but no changes can be made and 
saved. 

 This protects data from being changes on purpose or by accident. 
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6 Risk of using flawed software 

 Flawed software contains software bugs, which are small errors by programmers that may 
make the software or features within the software unusable. 

 Risks include: 
 Security error that may allow criminals to get into the system 
 Navigation systems can miscalculate your route. 
 Salary management software may not function correctly and workers might then not 

receive payment. 
 It could cause an application to crash repeatedly. 

 A virus was created on purpose to cause a problem whereas a software bug was created by 
accident. 
 

7 Software use – when, where and by whom 

 In order to buy the correct software ask yourself: 
 What will the software be used for? 
 When will the software be used? 
 Who will use the software? 

 Office suites contain a selection of applications such as a word processor and a 
spreadsheet application. 

 

Types of software that can help in various situations 

Situation Software type Software examples 

A professional photographer needs software to 
edit photographs he has taken with his digital 
camera. 

Photo manipulation 
software or photo editing 
software 

 Adobe Photoshop 
 GIMP 

Home users want video and audio editing 
software to edit home movies, add music or 
sound to their videos and share their movies on 
the web. 

Video and audio software  Adobe Premier 
Elements 

 Corel VideoStudio 

A user wants to be able to view a map, determine 
her route directions and locate points of interest. 
She wants to be able to search for places of 
interest, for example museums, airports and 
accommodation. She also wants to be able to 
calculate times and kilometres. 

Travel and mapping 
software 

 Google Earth 
 Google Maps 

Users want to play interactive computer games 
on game consoles and mobile devices. 

Entertainment software  Wii 
 PlayStation Move 

An accountant needs to keep track of financial 
records. 

Accounting package  Pastel 
 QuickBooks 



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 20 

Types of software that can help in various situations 

A publisher needs to create textbooks and 
magazines. 

Desktop publishing software 
(DTP) 

 Adobe InDesign 
 Scribe 

A business owner needs to keep track of all the 
stock in the business, with easy access to certain 
types of information. 

Database package  Microsoft Access 

A builder needs software he can use to record 
the details of a building project, and get the 
software to calculate the costs, taxes and totals 
automatically. 

Spreadsheet application  Microsoft Excel 
 LibreOffice Calc 

A user needs to send and receive e-mails. E-mail client  Windows Live Mail 
 Mozilla Thunderbird 

An architect needs software to help her draw up 
plans for a new building. 

Computer-aided design 
(CAD) software. 

 AutoCAD 
 TurboCAD 

 
7.1 Using a trial version 

 Make use of trial versions that can be installed free of cost. 
 Test the functions before spending money to buy the software. 

 

8 Social implications: user-centred design 

 Designed to work in the way that a user wants to work. 
 Designed to be easy to use and have features in logical places. 
 Advantages of a UCD approach include: 

 Users are less frustrated with the software. 
 Users need less training as the layout is logical and user friendly. 
 Users make fewer errors. 
 Users who have never used the application learn how to use it very quickly. 
 Users find websites easy to navigate. 
 Data entry can be easy to use. 
 Presentations are easier to present or understand. 
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Unit 4 System software and computer 

management (Term 3) 

1 Role of the operating system 

 The operating system is a set of programs responsible for controlling a computer. 
 The operating system maintains system software, runs applications and controls hardware 

devices. 
 Provides the user with an interface to tell the operating system what to do. 

 
1.1 Starting the computer 

Booting is the start-up procedure in which a computer checks that all its parts are working and 
the loads the operating system. 
 
1.2 Providing a user interface 

 The user interface is a way in which a user can control the computer.  
 Known as a Graphical User Interface (GUI). 
 Uses graphical elements such as icons, buttons, tabs and drop-down boxes instead of text 

commands instead of text commands. 
 

1.3 Managing applications 

 The operating system manages all of the applications within the computer system. 
 While the application is busy the OS assigns and controls system resources needed. 
 The operating system provides input from the user and returns the output. 

 
1.3.1 Controls single users and multiple users 

 Single-user operating systems only allow one user to work on the computing device at any 
time. 

 Single-user operating systems can connect to networks in order to use or share resources. 
 Multi-user computers are good solutions in situations where space and finances are an 

issue. This usually includes the use of thin clients and servers or mainframes. 
 Thin clients contain the absolute minimum hardware as most of the processing and storage 

happens on the server/mainframe. 
 

1.3.2 Controls multitasking 

 Multitasking is the process where a computer can process more than one task at the same 
time. 

 The operating system shares out resources in order for the processes to run at the same 
time such as downloading e-mail in the background while playing music. 
 

1.3.3 The Task Manager in the Windows operating system 

 Task Manager provides the user with information about tasks that are running on the 
computer. 

 Access the Task Manager by pressing Ctrl, Alt and Del together, then select Start Task 
Manager. 

 Information shown on the Task Manager includes: 
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 CPU and memory use 
 Applications being used 
 Network activity 
 Operating system services currently running. 

 
1.4 Management of files 

 The operating system controls all functions relating to the management of files: 
 Creating and editing folders and subfolders 
 Copying and deleting files and folders 
 Changing the attributes of files and folders 
 Sorting files according to type. 

 Files and folders need to be managed in an orderly way in order to save time. 
 

1.5 File types and properties 

 File properties include information such as file type, size, date created and modified. 
 The file type indicates the application needed to open the file, for example docx. 
 Metadata is a more detailed set of information relating to a specific file. 
 Metadata of a photograph may include the type of camera and the settings used on the 

camera to take the picture. 
 

1.6 Operating system utilities 

The operating system provides small programs/applications that help to keep the system 
running. These are called utilities. 

 
1.6.1 File management 

File management utilities such as Windows Explorer are designed to perform file management 
such as copying and pasting for files and folders. 

 
1.6.2 Scheduled updates 

 Updates are important to keep security up to date and have the newest features available 
on the computer. 

 Schedule updates to run automatically in order for it not to be possible for the user to 
forget doing updates. 
 

1.6.3 Compression 

 Compression allows users to make files and folders smaller with regards to their physical 
size on the storage medium. 

 Also known as zipping. 
 Uncompressing (unzipping or extracting) is returning the files to their original state. 

 
1.6.4 Backups 

 Backups need to be created on a regular basis and on multiple formats. 
 People do not make regular backups because: 

 They forget 
 Storage devices may be expensive 
 Backups may take a long time to make (depending on the amount of data). 
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1.6.5 Coordinate tasks 

 The operating system coordinates tasks and processes in order for problems not to occur 
due to two tasks trying to access the same printer. 

 Print jobs are placed in a print queue by a program called a print spooler on a first in first 
out (FIFO) basis, stored in a memory called a buffer. 
 

1.6.6 Control security 

The operating system controls the security on a computer by using built-in functions 
or 3rd party software: 

 Firewall: hardware or software that stops any unauthorised access to or from the 
network or computer. 

 Access control: uses details such as a username and password to restrict access to the 
computer or specific data 

 Anti-malware: keeps out malware such as spyware, viruses, worms and Trojans. 
 An adware blocker: Adware are free programs that companies pay for to have their 

advertisements being shown on the programs. Most are harmless but some need to be 
stopped as malware may be hidden in it. 
 

1.7 Antivirus software 

 System software designed to stop viruses from entering your system. 
 Tasks include scanning removable devices, checking e-mail attachments, when 

connected to a network to check network traffic and check websites for viruses. 
 

1.8 General troubleshooting using utility software 

 

Examples of utility programs and their functions 

Utility type Function 

File manager Used to manage files and folders on a computer; has functions such as copying, 
moving and deleting files and folders 

Disk Cleanup Removes temporary or unnecessary files from a computer to save space 

Disk defragmenter Checks whether a disk needs to be defragmented or not and, if necessary, 
defragments the disk 

Uninstaller Used to remove programs or applications permanently from a computer 

Backup software Makes automatic backups of the data or information on your computer, or 
assists with manual backups 

Data recovery Used to recover any files or folders that were deleted by accident 

Compression 
software 

Used to compress files or folders 
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2 Factors that influence performance 

 

2.1 RAM 

 Data used by the CPU is temporarily stored and then retrieved from the RAM. 
 RAM is much faster than secondary storage, and thus it is faster for the CPU to retrieve 

data from the RAM instead of secondary storage. 
 More RAM will allow more data to be stored for fast access 

 
2.2 Processors 

 CPUs have the greatest influence on the speed of the computer as all the calculations and 
instructions are done here. 

 A higher CPU speed will increase the speed of your computer. 
 

2.3 Number of applications running 

Each application running uses resources. If too many applications are running at the same time 
system resources will have to be split which will slow down the applications. 

 
2.4 Caching 

 Memory caching is when a small section of RAM is set aside that the CPU can access 
much faster than the normal ram. 

 Data that is used often is stored in a place where it can be quickly accessed. 
 Web caching saves often opened websites on your hard drive for fast retrieval. 
 Disk caching on a hard drive saves files used a lot in a fast piece of memory. 

 
2.5 Disk space and speed 

 The size of a disk will not have a great influence on the speed of a computer.  
However there must be enough open space for temporary files. 

 Newer hard drives allow for data to be accessed and retrieved faster. 
 

2.6 Malware – basic concepts 

 Malware: term used to describe any software designed to perform unwanted actions on 
your computer or generally disrupt its normal working.  

 Virus: Attaches to a file to be distributed. 
 Worm: Copies itself from one computer to another without user intervention. 
 Trojan: Represents itself as a harmless program or application. 
 Rootkit: Malware that is hidden in the system files of an operating system. 
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Questions 

1 In each of the following cases identify the type of user that is being described: 
1.1 A company representative travelling from one town to the next, selling new products. (1) 
1.2 A professional gamer being paid to test the newest games on the market.  (1) 
1.3 A home owner keeping record of the household expenses.  (1) 
2 Name ONE example in your school where using computers could accomplish these goals: 
2.1 Saving paper (1) 
2.2 Saving on communication costs (1) 
2.3 Saving time (1) 
3 Smartphones are devices that show the trend of convergence within computing devices. 

Name TWO more devices which may fall within the convergence trend. (2) 
4 How could the integration of input modes be used to help secure your PAT project  

on the server or computer in the computer centre? (2) 
5 Name TWO reasons why a webcam would not be suitable to take pictures or  

photographs at a prestigious event such as a prize giving. (2) 
6 What is OCR? Explain how the resolution of a scan might affect the OCR process. (3) 
7 The principal would like to install a voice recognition system to open the safe at school. 

However, only his voice will be allowed to open it. Why should he also allow a  
second or even third person to be able to access the safe via voice recognition? (2) 

8 Name ONE reason each why you would consider the following points when  
choosing a printer: 

8.1 Graphics capability (1) 
8.2 Colour (1) 
8.3 Mobility (1) 
9 Arrange the following in descending order according to storage size:  

DVD, CD, Blu-Ray (1) 
10 You recommended that the staff make use of cloud storage to bring documents  

to school from home. Name TWO reasons why this is a good idea.  
Describe what cloud storage is. (3) 

11 What is keylogging? (2) 
12 Rewrite each of the following false statements so they are true: 
12.1 Defragmentation does not speed up your computer, but it does open up  

a lot of storage space. (2) 
12.2 The Control Panel is accessed using the Ctrl, Alt and Del key combination. (1) 
12.3 LED monitors use more power than LCD monitors. (1) 
12.4 Web browsers cannot be used to access web-based applications. (1) 
13 Define the difference between a patch and a service pack by giving a definition  

of each one. (2) 
14 What is UCD? (2) 

TOTAL MARKS [35] 
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Answers 

1.1 Mobile user (1) 

1.2 Power user (1) 

1.3 Personal user (1) 

2.1 Any valid way to save paper such as using electronic documents instead of printing, 
preview documents before printing, etc.  

(1) 

2.2 Any valid way to save on communication costs such as using e-mail or VoIP instead of 
telephone calls.  

(1) 

2.3 Typing letter on a computer is much faster than writing them out in pen and e-mails are 
faster to send than traditional snail mail 

(1) 

3 Any TWO devices showing convergence such as smart TVs, refrigerators with monitors 
and Internet access, gaming consoles with internet browsers, etc.  

(2) 

4 By forcing a user to use multiple input devices to prove his/her identity such as a 
fingerprint/facial scan combined with a password. 

(2) 

5 Low resolution usually they cannot be used without being attached to a computer (2) 

6 OCR is a software process  that takes a scanned copy of a document and converts it to 
editable text.  If the scan is of a low resolution the software will not recognise the text. 

(3) 

7 If he has a cold or flu that affects his voice, they will not be able to open the safe. (2) 

8.1 Not all printers are able to print the same quality of graphics (1) 

8.2 Some printers (like most entry-level laser printers) can only print monochrome (1) 

8.3 If you need to travel a lot and would need the printer to be available at all time with you, a 
mobile printer would be needed 

(1) 

9 Blu-ray, DVD, CD (1) 

10 Cloud storage makes use of storage space on other servers through the Internet 
Teachers can access their files from any computer connected to the Internet  
No chance of leaving their work at home as with a flash drive 

(3) 

11 A type of spyware that records every keystroke on your keyboard. (2) 

12.1 Defragmentation speeds up your computer, and does not open up any storage space (2) 

12.2 The Task Manager is accessed by using the Ctrl, Alt and Del key combination (1) 

12.3 LED monitors use less power than LCD monitors (1) 

12.4 Web browsers are used to access web-based applications (1) 

13 A patch is a small piece of programming code meant to fix a specific problem within a 
software component, a service pack is a selection of patches that are combined into one 
download for easy installation 

(2) 

14 User-centred design (UCD) is a design philosophy that developers use to create software 
such as applications or websites that meet the needs and wants of the user.  

(2) 

TOTAL [35] 
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Chapter 2 Network Technologies 

Overview 

 

 

Unit 1 (Networks) is an overview of the components and concepts of a network and more 
specifically wide area networks (WANs) such as the Internet. You will need to know the 
social implications of networks and the Internet, and how to make an informed decision 
regarding Internet connections. You also need to examine the global impact of ICT. 
 
You need to be familiar with wide area networks, Internet services, types of Internet 
connections, social and security implications, improving security on the Internet, the impact of 
the Internet on the global community. 
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Unit 1 Networks (Term 2) 

1 Wide area networks 

1.1 Definition of a WAN 

 A wide area network (WAN) is a large network of computers that covers a wide area such 
as a city, province, country or even the world. 

 Communication methods include cables, microwaves, radio waves and satellites. 
 

1.2 The purpose and role of a WAN 

 The main purpose of a WAN is to connect LANs together. 
 Facilitate communication between users over a large distance. 
 Share a central data source 

 
1.3 The WAN called the Internet 

The Internet is a huge collection of LANs, servers and computers connected to each other by 
communication channels. 

 

2 Internet services 

2.1 Real-time messaging 

 Real time messaging is also known as instant messaging (IM). 
 Users exchange messages immediately, while other systems such as e-mail have a delay. 
 Allows users cheaper communication and multiple users at a time. 

 
2.2 Voice over Internet protocol 

 

Advantages and disadvantages of VoIP 

Advantages Disadvantages 

Much cheaper than normal telephone calls Audio quality is very low 

Text messages and file transfers can happen 
while you are talking using VoIP 

Calls can sometimes break and delays in 
communication can happen 

Video communication is also possible via VoIP Specific software needs to be installed, for 
example Skype® (although it is free) 

 Very difficult to trace the call in an emergency 
because there is no fixed location 
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2.3 File transfer protocol 

Internet service used to transfer files over the Internet. 
 

2.4 Cloud and grid computing 

 Cloud computing lets you make use of storage and applications facilities that are not 
necessarily hosted on your computer. 

 Data and applications can be accessed from any computer connected to the Internet. 
 Grid computing refers to the use of multiple computer systems as one. 
 Grid computing allows processes to happen over the multiple systems that will not be able 

to happen on one computer system, saving money. 
 

2.5 File sharing 

 Data is stored on servers around the world using the Internet to transfer files. 
 Examples include Dropbox and SkyDrive. 
 

Advantages and disadvantages of file sharing 

Advantages Disadvantages 

The latest version of your files will always be 
available to other users because the files are 
constantly synchronised, even when you modify 
them. 

There is no guarantee that your documents will 
be kept private. 

You can store the files and send the link to 
another user via e-mail. This means that you do 
not have a problem trying to attach large files to 
an e-mail. 

You will not be able to use your files if there is no 
Internet connection available. 

You can use a limited amount of storage space 
for free once you join. You may have to pay for 
more space – but it is relatively cheap. 

Managing your files on a file-sharing website may 
be a little more difficult than using a file 
management application on your own computer. 

You will not have the problem of leaving your files 
at home. 

If you have reached your cap limit, you will not be 
able to access your data. 

You can access your files from anywhere in the 
world using the Internet. 

 

You do not need any removable storage devices.  

 

3 Government Internet services 

Citizens can use services over the Internet to save time instead of standing in queues or 
visiting the relevant offices. 
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3.1 Election information 

 Election information can be posted on the Internet providing: 
 Up to date information 
 Facilities to make sure you are registered to vote 
 Detailed voting results. 

 
3.2 TV licence repayment 

Television licences can be renewed over the Internet instead of people having to drive to 
specific offices or other venues where payment can be made. 

 
3.3 Tax returns 

In the past taxpayers had to complete returns on paper whereas now it can be done 
electronically over the Internet. 
 

Advantages of e-filing 

Advantages for the taxpayer Advantages for SARS 

You can do your tax return at home. SARS can save paper because the forms are 
now filled in electronically. 

The Internet service is faster and more 
convenient than travelling to the nearest SARS 
office. 

SARS can input the information into the database 
quickly because the information is already 
electronic. 

You do not have to wait in long queues. More people are declaring their income and filing 
in their tax returns than in previous years, 
because the system is easy to use. 

Refunds are handled much more quickly than in 
the case of manual tax returns. 

 

E-filing is a secure way to do your tax return.  

 

4 Internet connections and access 

4.1 Types of connections 

Connection types include wireless and cabled connections. 
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Advantages and disadvantages of cabled connections 

Advantages Disadvantages 

Cheaper than wireless connections Fixed in a single location 

Connection is usually more reliable than wireless  

 
 

Advantages and disadvantages of wireless connections 

Advantages Disadvantages 

Can be used in places where cables cannot 
reach 

Connections lost more easily than wired ones 

Can connect to the Internet from anywhere where 
there is coverage 

More expensive per megabyte than cabled ones. 

 
4.2 Modems and routers 

 A modem is a device that connects a computer to the Internet via a telephone line. 
 A router is a device that connects two networks together. 
 An ADSL modem router is a device where both devices are combined in one. 

 
4.3 Broadband and bandwidth 

 Bandwidth: the amount of data that can travel from one point to another over a connection 
in a specific time period. 

 Broadband: describes a high speed (high bandwidth) connection to the Internet. 
 ADSL and 3G are examples of broadband connections. 

 
4.4 Data transmission speeds 

Data transmission speed measured in bits per second (bps) and kilobits per second (Kbps). 
 

4.5 Internet service providers 

 Company that has a permanent high-speed connection to the Internet. 
 The ISP then hires out the bandwidth to customers for a monthly fee. 

 
4.6 CAP and bundles 

 A cap is a limit placed on the amount of uploads and downloads a user may make on an 
Internet connection 
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Popular types of data caps 

Type of cap Description 

Hard cap This type of account stops all Internet access once the cap limit has been 
reached. 

Soft cap The user is allowed some Internet connectivity after the limit has been 
reached. Sometimes only local browsing is allowed and sometimes all 
browsing is allowed, but at a much slower speed. 

Uncapped An uncapped account has no download limit. Some ISPs may apply a fair 
usage policy in which a user may not exceed a certain amount of 
downloads within a given time, for example 10 GB a week. 

 
 A bundle is similar to a cap in that an operator allows the client a certain amount of data to 

be used. After the bundle is finished a user may be charged for data used thereafter. 
 

4.7 Shaped and unshaped accounts 

 Shaping allows for certain Internet functions such as browsing and e-mail to be given 
priority and activities such as streaming are limited. 

 All downloads on an unshaped account get equal priority. 
 

4.8 Downloading and uploading 

Downloading is when data is sent away from a computer over the Internet connection and 
uploading is when data comes into a system. 

 
4.9 Coverage and access points 

Coverage is a term used to describe the area where a connection is available. 
 
4.10 Internet services 

Internet services include e-mail, mailing lists, instant messaging, chat rooms, VoIP, FTP and 
newsgroups. 
 

5 Social implications 

5.1 Right to access and the right to privacy 

 Everybody has the right to privacy. 
 Only you have the right to access your own work and not anyone else. 
 Access rights help to protect data and information from outsiders. 
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5.2 Internet attacks 

5.2.1 DoS attacks 

A denial-of-service (DoS) attack is an attack where a computer is bombarded with huge 
amounts of data to slow down a computer or network. 

 
5.2.2 Sniffer attacks 

 A sniffer is a small program that can read packets of data being sent on a computer or a 
network. 

 Encryption is a process where data is translated into a secret code for secure transmission. 
 

5.3 Computer crimes 

Computer crimes include all crimes that are committed by using computers. 
 

5.3.1 Theft of hardware and software 

 Process of stealing the actual physical hardware. 
 Theft of software includes stealing the installation media. 

 
5.3.2 Identity theft 

A process where a criminal uses the personal details (identity) of a person to dishonestly apply 
for bank loans, access bank accounts and other criminal activities. 
 
5.3.3 Bandwidth theft 

 A person’s username and password is found out and a criminal will then use these details 
to access the Internet on the account of the victim.  

 Hotlinking is a process where a link on a website links to a file that is hosted on another 
website. This limits downloads on the primary website. 
 

5.3.4 Information and data theft 

Information such as personal details is stored in databases. These databases are valuable to 
advertising businesses to whom criminals then sell them. 

 
5.3.5 Theft of time and services 

 When employees use a computer to browse social networking sites or conduct their own 
personal matters they are using resources owned by the company without permission. 

 This use also leads to time being lost that should have been used for company business. 
 

5.4 Internet-related fraud scams 

 A scam is the process in which criminals get people to give them money by tricking them. 
 A hoax e-mail is an e-mail that tries to deceive you by using a story that you cannot check 

is true. 
 

5.5 Computers can be taken over 

 A zombie is a computer that has been taken over by a criminal and is being controlled 
from a different physical location. 

 The criminal can use the computing power and Internet connections of the zombie army to 
perform multiple DoS attacks, send spam or spread malware to other computers 
around the world. 
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 Bots are independent programs that perform automated tasks over the Internet.  
 Bots perform tasks that are simple and repetitive much faster than humans can 
 Bots can be used for malicious purposes such as collecting e-mail addresses from web 

pages to be used for spam. 
5.6 Misuse of personal information 

Information should be private and not be sold or distributed. 
 

6 Security issues 

6.1 Malware and spyware 

 Malware is the term we use for harmful software such as viruses, Trojans and worms that 
perform unwanted actions on a computer, or generally disrupt the way a computer 
normally works. 

 Spyware is a type of malware that secretly collects information such as your browsing 
history or even redirects websites and slows down the Internet connection. 
 

6.2 Adware 

 Adware is any application that displays online advertisements on web pages, e-mail or 
other Internet services. 

 Adverts can be in the form of banners or pop-ups. 
 

6.3 Pop-ups 

A pop-up is an advertisement that opens in a new window, usually displayed on a web page in 
the user’s web browser. 

 
6.4 Keylogging 

Keyloggers are examples of spyware that records key combinations such as usernames, 
passwords and pin codes. 

 
6.5 Firewall protection 

Hardware or software that stops any unauthorised access to or from the network or computer. 
 
6.6 Avoiding security threats 

 Avoid security threats by: 
 Updating all of the software to avoid security problems 
 Using encryption to send important data 
 Installing anti-malware software 
 Scanning removable devices for threats before use 
 Not opening e-mail or e-mail attachments before scanning for malware 
 Not visiting websites where threats may possibly be 
 Not installing software from unverified developers. 
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7 Security safety measures 

 

Types of security software 

Type of software Example 

Antivirus software to prohibit any virus infections Norton, McAfee, Kaspersky, 
Bitdefender 

Anti-spyware to stop any spyware infections Kaspersky, Bitdefender 

Firewall to prevent any unauthorised access to your 
computer or network 

ZoneAlarm, Comodo 

Updates to fix any security issues within the software Patches and service packs 

Anti-spam package to prevent spam e-mails entering your 
computer 

Norton, McAfee, Kaspersky, 
Bitdefender 

 

8 The impact of technology on the global community 

Technology has created a global village where everybody can communicate and interact as if 
we live in one small village. 
 
8.1 Communication 

 Communications technologies include: 
 E-mails being sent and received almost immediately 
 Video conferencing 
 Cell phones allowing calls from almost anywhere. 

 
8.2 Banking 

Banks allow users to complete banking tasks such as transfers and paying accounts from 
anywhere using Internet or cell phone banking. 
 
8.3 Commerce 

Businesses have a larger, global market to sell to. 
 

8.4 Social networking 

Allows users to keep up to date with their friends. 
 
8.5 Distributed computing power 

 Distributed computing power or grid computing is the use of multiple computer systems as 
if they were one computer. 

 A company can save on costs using this type of processing because a process can make use 
of processing power that is not currently in use. Instead of buying a new powerful 
computer, the company can use existing unused processing power and storage space. 
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Questions 

1 Why can the Internet be described as a WAN?  (1) 
2 Name TWO advantages of real-time messaging. (2) 
3 Define the term cloud storage. (2) 
4 Name TWO advantages for the government with regards to tax return being done 

electronically via e-filing on the Internet. (2) 
5 Explain what the difference is between a router and a modem by referring to the  

function of each. (2) 
6 How would the term bandwidth influence your choice of Internet connection? (2) 
7 Your new uncapped ADSL Internet connection is soft capped at 50GB per month.  
7.1 What does 'soft capped' mean? (2) 
7.2 The account is also a shaped account.  

How could this impact your use of the connection?  (2) 
8 Why would a DoS attack be performed? (1) 
9 Briefly define each of the following terms: 
9.1 Spyware (1) 
9.2 Pop-up (1) 
9.3 Keylogger (1) 
10 What type of software can be used to protect your computer from illegal attempts  

to access it via a network or the Internet? (1) 
 

TOTAL MARKS [20] 
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Answers 

1 The Internet is a very large collection of networks and computers around the world that are 
interconnected.  

(1) 

2 Much cheaper than traditional communications such as telephone calls and many users 
can communicate at the same time. 

(2) 

3 Data is stored on servers/computers other than your own using the Internet to transfer 
data to and from your computer to the server. 

(2) 

4 Any TWO of the following: 
 SARS saves on paper use. 
 SARS can input data into their database much more quickly as the information is 

already available electronically and need not be entered manually. 
 More people are declaring their tax incomes as it is much easier than in the past. 

(2) 

5 A router is a device used to connect two networks together whereas a modem is used to 
connect a network or computer to the Internet via a telephone line. 

(2) 

6 Bandwidth refers to the amount of data that can travel from one point to another via a 
connection in a set period of time. This means that you need to choose a line that will 
suit your use: a faster line for high usage or a cheaper, slower line for average use.  

(2) 

7.1 When the 50 GB soft cap is reached, the line will be throttled to a lower speed, or you may 
only be allowed to browse South African based websites.  However your Internet 
connection will NEVER be stopped as it is an uncapped account.  

(2) 

7.2 Certain protocols will be given a lower priority such as streaming video and downloading. 
Other protocols such as normal browsing and e-mail are given high priority.  This means 
that if you got the connection to serious downloading or streaming video, the connection 
will not fulfil your needs.  

(2) 

8 To slow down a computer or network as much as possible, to a point where the system 
may even crash.  

(1) 

9.1 Spyware is a type of malware. The software secretly collects data about the computer and 
the user.  

(1) 

9.2 A pop-up is an advertisement that opens in a new window, usually displayed in a web 
page in the user’s web browser, while he or she is working on the computer.  

(1) 

9.3 Keyloggers are an extremely dangerous type of spyware because the creator or installer of 
the keylogger can use the program to record key combinations such as usernames, 
passwords and PIN codes.  

(1) 

10 A firewall (1) 

TOTAL [20] 
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Chapter 3 Internet Technologies 

Overview 

 

 

 

 

 

 

 

 

 

 

 

Unit 1 (Internet technologies) deals with types of Internet technologies such as video 
conferencing as a mode of communication. We look at the advantages and disadvantages, as 
well as good practices of using digital communication.  
 
You will need to revise the typical features of web browsers which include bookmarks, history 
and favourites. You need to know about home page settings of your web browser, pop-up 
blockers, blocking of websites, caching and browser plug-ins. 
 
You need to be familiar digital communication; including the advantages, disadvantages and 
limitations of digital communication; good practices in digital communication; uses of 
computer communication; and new trends and technologies in digital communication. 
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Unit 1 Communication (Term 3)  

1 Types of digital communication 

 Digital communication is the way in which one computer or mobile device transfers data 
from one device to another.  

 Standards and rules called protocols control the way devices send and receive data.  
 Some examples of digital communication are: e-mails, picture/video messaging, blogs and 

wikis, and social networks.  
 

1.1 Video conferencing 

 Video conferencing is the process by which users use a network of computing devices to 
see, talk and hear one another even though they are in different locations. 

 Video conferencing is used by businesses to conduct meetings between colleagues from 
different countries. 
 

1.1.1 Hardware and software required for video conferencing 

Good reliable equipment is needed to set up a video conference. For example, a high speed 
computer, high resolution monitor, a webcam, speakers, and microphones and also a 
connection to the network as well as web-based software installed on the computers. 
 

 
1.1.2 Good practices for video conferencing 

 Keep to only the matters that need to be discussed at the meeting. Maintain eye contact 
with the people in the meeting. 

 The room must be quiet and there should not be noisy distractions in the background.  
 Talk clearly and simply. 
 Only run the computer program used to communicate. No other program must be open 

during a video conference. 

  

Advantages and disadvantages of video conferencing 

Advantages Disadvantages 

Video conferencing can save money on travelling to 
another country to attend a meeting. 

It is expensive to set up a video lab and 
maintain the conferencing equipment. 

Visual and audio information can be shared through video 
conferencing. 

Users must be fully trained to use the 
equipment. 

One-on-one meetings are possible between people who 
are far apart as they can see who they are talking to. 

A power failure will cause a break in 
communication. 

Video conferencing enables collaboration and can 
strengthen relationships between colleagues who work far 
away from each other. 
 

Time zones differ across continents, which can 
be inconvenient for some people in a video 
conference. 
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2 Uses of computer communications 

Computer communication is the most common and the fastest form of communication today. 
 
2.1 RSS feeds 

 RSS stands for Really Simple Syndication. 
 An RSS feed is a service designed to deliver regular Internet content and news updates 

directly to subscribers. 
 

Advantages and disadvantages of RSS feeds for subscribers 

Advantages Disadvantages 

Subscribers are able to access news whenever they 
want to. 

Not all RSS feeds display graphic, video or audio 
material from the original site. 

RSS readers can be customised so that the 
subscriber may access the news from different 
news groups on one page. 

The URL or identity of the original source is not 
shown on the RSS feed, which could cause 
confusion for subscribers as they may not know 
what they are actually reading. 
 

A subscriber is able to capture and republish news if 
he or she has a website that collects news from 
other sites. 

Many users still prefer email messaging, rather 
than having to visit a website. 

 
 

Advantages and disadvantages of RSS feeds for publishers 

Advantages  Disadvantages  

RSS offers easy and simple publishing as 
subscribers will access the feed and get updated 
content automatically using the reader. 

The publishers cannot see how many users 
subscribe to their websites or how frequently the 
visits to the feeder are. 

RSS offers a simpler writing process as new content 
to your website is written in the form of titles and 
short description and then links back to the website. 
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2.2 Bogs/vlogs 

 A blog is a website that contains posts or pieces of information that are in the form of a 
diary or journal. 

 Blogs can be created and used by: 
 Teachers who want to work with learners. 
 Anyone who wishes to share hobbies, interests, opinions or parts of their personal life 

with others. 
 Businesses that want to communication with customers, employees and other 

important people. 
 A vlog is a video blog.  
 Vlogs are created by recording an event and publishing it on the blog so that other users 

can view it. 
 
2.2.1 Create a blog 

 Decide what you want the blog to be about. 
 Decide whether you are going to use a free blogging service or whether you will host the 

blog yourself. 
 

Characteristics of free blogging services and hosting a blog 

You do not own the blog. You have more freedom to do what you want. 

You will not get your own domain. You will have a domain name. 

If you move to your own domain, you cannot 
take your readers with you because you have no 
control over the site. 

Hosting your own blog is relatively cheap. 

 
2.2.2 How to register a blog space using Blogger.com by Google 

 Connect to the Internet. 
 Make sure you have a Google Gmail account. 
 Type www.blogger.com or www.blogspot.com in the address bar of your web browser and 

then select the site. 
 Follow the prompts on the sign-up screen. 
 You can then starting blogging and specify the settings, change the layout and view of 

your blog. 
 Click the Sign out button to leave the blog. 
 Other users will have to type in your blog address in the address bar of their web browsers 

if they want to view your blog. 
 

2.2.3 How to publish a blog through Word 2010  

 Launch Microsoft Word 2010, click on file, select New and then click on Blog Post. 
 Follow the prompts on the Register a Blog Account. 
 Select your blog service provider from the drop-down list on the New Blog Account 

dialogue box.  
 Each service provider will require different details. 
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Advantages and disadvantages of a blog 

Advantages Disadvantages 

Blogs are easy to create and can often be 
created for free. 

A blogger can spend a lot of time writing the blog in 
a logical manner. 

People can be part of an online community and 
use blogs to share their knowledge with other 
people who have similar interests. 

A person needs to update their blog regularly to 
keep readers interested in the blog. 

A person can use a blog as a diary. 
 

Bloggers must be careful about the information they 
post on their blog, especially if anyone is allowed to 
read the blog. 

 

2.3 Podcasts/vodcasts 

 A podcast is a recorded audio file that is usually stored in an MP3 or MP4 format. 
 A vodcast is a video podcast that contains video and audio information. 
 

Advantages and disadvantages of podcast/vodcasts 

Advantages Disadvantages 

Podcasts are a way to communicate and allow 
users to hear material. 

Podcast/vodcasts do not really allow the audience to 
join in or interact. 

Vodcast allow users to see and hear material 
such as demonstrations. 

Sufficient bandwidth is needed to download 
podcasts/vodcasts. 

Users are able to listen to downloaded podcats 
and see and hear vodcasts when and where it 
suits them. 

An entire file downloaded and this may take up a lot 
of storage space. 

Information travels quickly using 
podcasts/vodcasts so people are able to get 
updated information quickly. 

People with hearing impairment will not find a 
podcast very useful. People with sight impairment will 
not find a vodcast very useful. 

 
2.4 Wikis 

 A wiki is a website that allows users to create, add to, remove, edit or delete website 
content via their web browser. 

 One popular wiki is Wikipedia®, which is a free web-based encyclopaedia. 
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2.5 Global positioning systems 

 A global positioning system (GPS) is a system that uses signals from a satellite to calculate 
exactly where you are in the world. 

 GPS receivers can be in devices used by people travelling in a car or boat and by people 
going on a hiking trail. 

 Many mobile devices such as smartphones have GPS technology in them. 
 

2.5.1 Uses of GPS technology 

Devices with GPS technology in them can be used to: 
 work out directions to a place 
 create a route map and choose the best route from one place to another 
 find another route to avoid traffic jams 
 find facilities such as restaurants, petrol stations, entertainment places, schools and hotels 
 locate a stolen vehicle or lost person. 
 

Advantages and disadvantages of a GPS 

Advantages Disadvantages 

A GPS is a tool that helps a user get directions 
to geographical places quickly. 

Sometimes the signal to a GPS device can be blocked 
by storms or heavy cloud cover. Overhead bridges 
and tall buildings can also block signals. 

A GPS device can be plugged into a car’s 
cigarette lighter to get power from the car 
battery. 

A GPS device needs power, so the battery needs to 
be charged regularly for it to work. 

A GPS can help locate a person quickly if he or 
she is in danger or is involved in an accident. 

Some people may not have the money to buy a GPS 
device. 

A GPS can be used produce maps of 
geographical areas. 

GPS devices are small so they can be easily lost or 
stolen. 

GPS software is updated regularly to cover the 
whole world. 

While driving, a driver may spend more time looking at 
the GPS screen than at the road, and this could cause 
an accident. 

A GPS can be used at sea to locate a ship’s 
position. 

Technology can fail at any time, so the user should 
have a backup resource such as a map book as well. 

 

2.6 Social networks 

 Online social networks are also known as social networking websites.  
 An online social network is a group of users who have registered to use a website to share 

their interests, ideas, stories, photos, music and videos with one another. 
 To join an online social network you usually need to have an e-mail address. 
 The social networking website uses the profile of each user to maintain the user’s links to 

friends and family members. 
 Most social networks offer communication services such as chat rooms and newsgroups. 
 Examples of social networks are Facebook, Twitter, Google+, MySpace and LinkedIn. 
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3 Typical features of web browsers 

 A web browser finds a web page by using the web page’s web address (this is also called 
the uniform resource locator or URL). 

 Web browsers also use the coding to create the links between web pages and websites. 
 

3.1 Bookmarks (favourites) 

 A bookmark is a saved web address that a user can access by clicking on its name in a list. 
 To save time, users often save the web addresses or URLs that they wish to visit again. 
 

3.2 History 

 Most web browsers keep a record of your browsing history and have a feature called 
History.  

 You can use the History feature to revisit a web page, especially if you do not remember 
the URL.  

 
3.3 Home page settings 

 A home page is usually the first page you see when you open a web browser. 
 You can instruct your web browser what web page it must use as your home page. 
 This can save you a lot of time because you will not have to re-type the URL in the 

address bar to revisit this favourite web page. 
 You can change the home page this way: 

 Launch your Internet browser by clicking on the Start button or using the icon on the 
status bar at the bottom of your screen. 

 Once the web browser is open, click on Tools, then Options (or Internet options), and 
then select General. 

 Type in the name of the page you want as your home page, for example: 
http://www.google.com. 

 

3.4 Adware and spyware removers, and pop-up blockers 

 Adware is software that has advertisements within the application. Adware is not illegal. 
Advertisers pay software developers to place their advertisements in banners and pop-
up windows on web pages, e-mail and other Internet services. 

 A pop-up ad is an Internet advertisement that suddenly appears in a user’s web browser 
window while the user browses the Internet. 

 A pop-under ad is an advertisement that hides under (behind) an active window. 
 Anti-spyware software is software that finds and deletes spyware. 
 A pop-up blocker is a program that stops pop-up ads displaying on a web page. 

 
3.5 Blocking websites 

Blocking websites is the process in which Internet access is controlled so that some websites 
cannot be viewed.  
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3.5.1 How to block a website 

 If you use Internet Explorer, clock on the Tools tab, select the Internet Options menu item.  
 Click on the Privacy tab and then click on Sites.  
 Type in the URL or address of the website you want to block.  
 Click on Block, then OK. This will block one site at a time. 
 Other web browsers will have similar options. 

3.6 Caching 

 A cache is an area of memory that stores frequently used data or instructions. Some 
browsers have a cache area called ‘Temporary Internet Files’.  

 Two important reasons why a cache is useful: 
 Time is saved because the web browser can find some of the information it needs on 

the computer's own hard drive. 
 Less data needs to be transmitted over the network because the web browser already 

has some of the information it needs. This reduces the amount of bandwidth used, 
which in turn can save the user money. 

3.7 Browser plug-ins 

 A web browser plug-in is an additional piece of software that gives a web browser more 
functions. 

 Plug-ins can improve videos, multimedia, animation and games. 
 Some plus-ins do not update automatically, so you need to update your plug-ins to 

improve the computers' web security. 
 Old plug-ins can waste your time if they cause interruptions while you browse the Internet. 
 Old plug-ins can carry security threats and can increase the risk of malware infections and 

virus attacks on the computer. 
 

Examples of browser plug-ins 

Plug-in 

application 

Description 

Web 

address 

Adobe Reader Allows you to view portable document format (PDF) files.  
When you view these files, they look the same as they will when 
they are printed.  

Adobe.com 

Flash Player Displays web pages across a whole screen, showing clear 
graphics and animation, together with very good sound 

Adobe.com 

Quick Time Enables you to view and listen to animation, music, audio and 
video directly on a web page 

Apple.com 

Java Enables web browsers to run programs written in Java. This 
adds interactivity to web pages. 

Java.com 

Silverlight Videos can be watched directly through a webpage without 
needing to install a specific program such as Windows Media 
Player. Also items such as graphics can be used on a website 
without needing to install separate plug-ins. 

Microsoft.com 

Windows Media 
Player 

Enables you to listen to audio, play or edit WMA, MP3and MP4 
files, burn CDs and watch DVD movies. 
 

Microsoft.com 
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4 Digital communications 

 Digital communication is the exchange of information between users through the use of 
technology.  

 Some examples of digital communication are video and web conferences, blogs, wikis and 
online social networking. 

4.1 E-mail 

Electronic mail or e-mail is a method of exchanging messages and files between computers or 
mobile devices over a computer network such as the Internet.  

 
4.1.1 Setting up a contacts list 

 The e-mail application allows you to create a contacts list.  
 To set up a contacts list in the Outlook e-mail application click on the Home tab, and select 

New Item.  
 Click on the Contact option, or use the shortcut Ctrl+Shift+C.  
 This will open a contact window. You can now type in the contact details of the person you 

want to add to your contact list. 
 
4.1.2 Setting up a contact group (distribution list) 

 To set up a contact group, also known as a distribution list, in the Outlook e-mail 
application: 

 Click on the Home tab, and select New Items.  
 Select Contact Group (from the More Items option) or use the shortcut, Ctrl+Shift+L. 
 Click in the Name box and type in a name for your group, for example ‘CAT friends’.  
 You can now select the Add Members option for any of the entries in your Outlook 

Contacts or Address Book.  
 You also have the option to select New E-Mail Contact from the Add Members option. 
  If you select the New E-Mail Contact option, a dialogue box requesting the details of 

the new member will appear and you will have to type in the new member’s name and 
e-mail details.  

 Once you have added the contacts that you want in your contacts list, click on Save 
And Close. 

 
4.1.3 Setting tasks 

 An e-mail account also allows users to set tasks and remind themselves of those tasks.  
 Tasks are stored in e-mail folders and can be linked to e-mails. 
 Users can create notes that will remind themselves of important dates and events (for 

example, meetings). 
 

4.1.4 How to create a task 

 Click on the Home tab, and then in the New group, click on the New Task button, to 
open the task window. 

 In the Subject window, type a name for the task. You can add other details such as start 
date, due date, status and priority. 

 On the Task tab, in the Actions group, click on the Save & Close button. 
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4.1.5 Archiving 

 The e-mail archive is an organised way to save old e-mails so that they are still available if 
they are needed at later date.  

 Steps to follow to archive e-mails in the Outlook e-mail application: 
 Click on the File tab, and then Cleanup Tools. 
 Click on Archive, and then select the radio button next to the Archive this folder and 

all subfolders option.  
 In the list that is displayed, click on the folder you want to archive. All subfolders of 

this folder will also be archived.  
 Click on OK. 

 
4.2 Strengths and weaknesses of digital communication 

 Digital communication can be effective or not, depending on how you use it. 
 In the next table, you can read about some of the strengths and weaknesses of digital 

communication. 
 

Strengths and weaknesses of digital communication 

Strengths Weaknesses 

Digital communication is very fast over both short 
and long distances. It is also reliable and easy to 
use. 

It can be difficult to prove that a digital 
communication is from the person it says it is 
from, as it cannot be recognised through a 
handwritten signature. 

Digital communication is much cheaper than 
postal services, for example, universities can send 
messages to many students at the same time. 

Digital communication can make it difficult for 
people to separate their social lives from their 
work lives. 

You can use more than one type of digital 
communication at the same time: for example, 
videos can be uploaded at the same time as data 
and audio files. 

People such as hackers, crackers, fraudsters and 
cyber predators misuse digital communication for 
harmful purposes. 

 
4.3 Advantages and disadvantages of digital communications 

Digital communications have made our lives much easier. The next table lists some of the 
advantages and disadvantages of digital communications. 
 

Advantages of digital communication 

Advantages  Disadvantages 

Digital communication contributes towards 
green computing and protecting the 
environment because costs can be saved if 
no printing takes place and no paper, ink 
cartridges or toner is wasted. 

Some people may misuse digital communications to 
send viruses or hoax messages to harm other people. 
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Advantages of digital communication 

Files can be saved electronically on various 
storage media for later use. 

Digital communication equipment such as cellphone 
and microwave towers may not fit into the environment 
or be pleasant to look at. 

People from all over the world are able to 
collaborate and share communications, 
graphics, interactive software, etc. 

Many people cannot use computers and so cannot 
take full advantage of digital communication. 

Messages can be read anywhere and at any 
time, and communication is much cheaper. 

Some people may become addicted to cyber activities, 
which may lead to social withdrawal or anti-social 
behaviour. 

Digital communication enables facilities such 
as video conferencing, which can save a lot 
of time and money. 

There is no guarantee of privacy especially with e-mail 
messages, which can be read by others. 

 
4.4 Limitations of digital communication 

 Digital communication has become very popular, but it has limitations. 
 Electromagnetic fields and radio signals can interfere with wireless communication. 
 
4.5 Good practices in digital communication 

It is important for users to apply good practices when using digital communication.  

5 Communication devices 

Some of the more modern communication devices are small enough to hold in your hand. 
These devices are called handheld devices. 
 
5.1 Tablet PCs 

A tablet PC is a special type of notebook computer that allows users to write using a digital 
pen. 
 
5.2 Personal digital assistants 

A personal digital assistant (PDA) is a handheld device that provides useful features such as a 
calendar, a digital camera, an appointment book, a calculator and a notepad.  
 
5.3 Smartphones 

 A smartphone has the features of a PDA and a cell phone.  
 Smartphones are Internet-enabled so you can send and receive e-mails and surf the 

Internet. 
 
5.4 New trends and technologies 

Businesses are developing new applications, products and communication devices all the time 
to make communication and work easier. 
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6 Social issues linked to digital communication 

New trends in technology have helped many people, especially consumers and travellers. 
For example, it has improved services at airports and cinemas by increasing the speed at 
which people can be served. 
 
6.1 Impact and use of social networking sites and technologies 

Technology has made the world a global village where people all over the world can 
communicate with one another like neighbours. 
 
6.1.1 Facebook 

Facebook is an online social networking service that provides a way for people to interact and 
chat by sharing interests, activities, photos, videos and so on. 
 
6.1.2 Twitter 

Twitter is a free online social network. It is also called a microblogging service because 
people share their thoughts and interests by using very short messages called tweets. 
 
6.1.3 LinkedIn 

LinkedIn is a social network site where professionals exchange and share information. 
 
6.1.4 MySpace 

MySpace allows a user to add a photograph and some brief information about his or her 
personal interests - after he or she can communicate with their MySpace contacts. 
 
6.1.5 Virtual communities 

A virtual community is a group of people who share their common interests through e-mails, 
social networks and blogs. An example of a virtual community can be found on the website 
Second Life. 

6.2 Impact of technology on the global community 

Technology has helped the global community because it has given people the ability to 
telecommute. 
 
6.2.1 Telecommuting (teleworking) 

Telecommuting (teleworking) is the process by which a person is able to work from home 
using technologies such as a home computer, a fax machine and a telephone to communicate 
with colleagues and customers in different places. 
 

Advantages and disadvantages of telecommuting 

Advantages Disadvantages 

Many businesses have found that telecommuters 
have greater work satisfaction, and are more 
productive, than people who work in offices. 

Not all people can manage or schedule their time 
well when working as a telecommuter. Some 
managers may also mistrust the telecommuters. 

Flexible working hours allow telecommuters to run 
errands during the day without losing work time. 

Many people need social interaction with other 
people and may feel isolated if they telecommute 
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Advantages and disadvantages of telecommuting 

The environment is preserved because there are 
now fewer cars, buses and taxis on the road, 
which reduces the amount of pollution. 

 

Telecommuters are generally less stressed 
because their working hours are more flexible. 

 

 

6.2.2 Computer fraud 

 The Internet makes it possible for criminals to access millions of interconnected 
computers.  

 Computer fraud, also known as cybercrime, is any crime that involves the use of a 
computer to deceive someone, steal data and information or cause harm.  

 Some examples of computer fraud: 
 E-mail hoax: A false message, for example a message that describes a new virus, a 

missing child or a prize that you have won. It could also be a chain letter requesting 
you to forward the original message to others. 

 E-mail spoofing: The process in which a criminal sends an e-mail with a web address 
and logo that looks like it comes from a different person or company. 

 Identity theft: The crime in which the criminal steals a person’s personal or financial 
information so that the criminal can pretend to be that person. 

 Data theft: The crime in which data is stolen from computers or handheld devices. 
Spyware is often used to gather information on people. Some data theft involves 
accessing a business’s databases and stealing customer information from them. 

 Phishing: The process of getting sensitive information such as user names, passwords, 
bank account numbers or credit card details. Users are asked to enter their details on a 
fake website that looks similar to the website the user expects to see. 

 Pharming: The process in which a user is redirected from the right website to a fake 
website, without the user being aware of it, so that the user’s personal details can be 
stolen. 
 

6.3 How technology can benefit and harm society 

Technology has many benefits but it can also be harmful. Let us look at some of the good and 
bad points of technology. 
 
6.3.1 How technology can benefit society 

 Some ways that technology has benefited society are: 
 In the medical field, doctors can take part in webcam consultations to get advice on 

difficult surgery. Robotic surgery has also benefited society. 
 Communication: Technology has made communication much simpler and easier. 

People are able to communicate from different parts of the world more cheaply. 
 Banking and finance: Technology has made banking easier and more convenient.  

E-banking can be done from the security and comfort of home at any time of the day. 
 Education: Distance learning is possible through technology. Students can submit their 

assignments online and access lectures or academic material via vodcasts. 
 Closed circuit television (CCTV) and geographic information systems (GIS) are able 

to help fight crime by showing the locations where crimes occur. 
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6.3.2 How technology can harm society 

 Some of the ways that technology can harm society are: 
 Internet technologies can reduce the personal and social interaction between people. 
 People may become less physically active, which could lead to obesity and ill-health. 
 The overuse of technology may cause physical harm to people, for example, repetitive 

strain injury (RSI), carpal tunnel syndrome (CTS) and eye strain. 
 Technology processes may result in unwanted by-products that pollute the 

environment. 
 E-waste can also harm the physical environment. 
 People such as drug peddlers and addicts can use the Internet to find out how to create 

dangerous drugs from simple household chemicals. 
 Criminal activity, such as identity theft and phishing over the Internet, can cause 

people to lose large amounts of money. 
 Young people may be persuaded to join groups that have hidden motives because 

instant messaging and social networks make it so easy for people such as cult leaders 
or paedophiles to reach young people and commit crimes. 
 

6.4 Use of information sources from around the world 

 The Internet has become a major information source in the world.  
 Even traditional information sources such as newspapers, television, magazines and radio 

use their own websites on the Internet to spread information. For example, the 
television service of the South African Broadcasting Corporation (SABC) has a 
website at www.sabctv.co.za  

 E-zines (electronic magazines) and e-books (electronic books) not only provide 
information, they also contribute to green computing because their electronic versions 
save paper. 

 
6.5 Information overload 

 Information overload happens when there is too much information for the brain to process.  
 Information overload can cause people stress. 
 Some ways to control information overload are: 

 Spend time on the information that you need to know rather than information that is 
nice to know. 

 Control information overload by processing or sorting out the information before 
passing it on to other people. 

 When sending an e-mail, ensure the message is short and to the point. 
 Focus on one task at a time, then move on to other tasks. 

  

http://www.sabctv.co.za/
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Questions 

1 Clearly define digital communication.  (2) 
2 How can video conferencing influence communication in business?  (2) 
3 What is the main function of a GPS technology?  (1) 
4 Describe the function of an RSS feed.  (2) 
5 Name two advantages of an RSS feed and two disadvantages of  

an RSS feed for subscribers.  (4) 
6 Differentiate between a podcast and a vodcast.  (2) 
7 Briefly define each of the following terms:  
7.1 Caching  (1) 
7.2 Smartphones   (1) 
7.3 MySpace  (1) 
8 Name any two web browser plug-in applications.  (2) 
9 What is telecommuting?  (2) 
10 Give three ways in which a learner can deal with information overload.  (3) 

TOTAL MARKS [23] 
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Answers 

 
1 Digital communication occurs when computer or mobile devices transfer data between 

each other.  
 
(2) 

2 Communication has become convenient between colleagues who live in different 
Geographic locations.  

 
(2) 

3 GPS technology allows the devices to receive and send signals.  (1) 
4 An RSS feed is a service designed to deliver regular Internet content and news updates 

directly to subscribers 
 
(2) 

5 Advantages of an RSS feed: 
Subscribers can access news whenever they want to. RSS readers can be customised 
so that the subscriber may access the news from different news groups on one page.  
Disadvantages of an RSS feed: 
The URL or identity of the original source is not shown on the RSS feed, which could 
create confusion for subscribers as they may not know what feed they are reading.  
Many people are still not exposed to RSS feeds and so they prefer e-mail messaging.  

 
(1) 
(1) 
 
(1) 
(1) 

6 A podcast is a recorded audio file that is usually stored in an MP3 or MP4 format.  
A vodcast is a video podcast that contains video and audio information.  

(1) 
(1) 

7.1 

 

7.2 

 

7.3 

Cashing: cache memory is an area of memory that stores frequently used data or 
instructions.  
Smartphones: smartphones are Internet-enabled so you can send and receive e-mails 
and surf the Internet.  
MySpace: initially designed to help young people such as students communicate.  

 
(1) 
(1) 
(1) 

8 QuickTime 
Java 

(1) 
(1) 

9 Telecommuting is the process of working outside of the office environment using 
electronic devices such as fax, emails and other communication devices.  

 
(2) 

10 Any three of: 
 Spend time on information you need to know, rather than on information that is 

nice to know.  
 Control information overload by processing or sorting out the information before 

passing it on to other people.  
 Ensure the e-mail messages are short and to the point.  
 Focus on one task at a time, then move on to other tasks. 

 
 
 
 
 
(3) 

 
TOTAL [23] 
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Chapter 4 Databases 

Overview  

 

This chapter comprises three units in the Learner’s Book and one unit in this Study Guide.  
 
Unit 1 (Reports and queries) covers the concepts, knowledge and skills required for 
databases. It explains basic skills such as creating and editing tables; queries; forms and 
reports; assigning data types; data validation; doing calculations and integration; and more 
advanced skills such as calculations in queries, grouping in reports and calculations in report 
groups. 
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Unit 1 Reports and queries (Term 1)  

1 Reinforce content, concepts and skills 

1.1 Getting started 

 We use databases to store related data. We store this related data in records, which are kept 
in tables. Tables are kept in databases. 

 To open a database application:  
 Click on the Windows Start button and choose All Programs.  
 Click on Microsoft Office and then on Microsoft Office Access. 

 To create a database:  
 Click on Blank Database and type the name you want to give your database in the File 

Name box.  
 If you then click on the Browse icon, the File New Database window appears.  
 Open the folder that must store your database.  
 The name of the file you entered appears in the File Name box.  
 Click on OK, and then the Create button. 

 To open an existing database:  
 Click on More, on the right-hand side of the screen.  
 Browse to find the folder that stores the database.  
 Click on Open. 

 
1.1.1 Objects 

 Tables store data in rows (records) and columns (fields). 
 Queries select data from tables. You use criteria to tell the query what data to select. 
 Forms are data entry windows. These windows make it easy for users to enter data. 
 Reports organise and/or summarise both the tables and the queries. 
 Macros are recorded sets of actions, such as clicks. We create them to perform particular 

tasks. 
 Modules are small programs written in a programming language called Visual Basic.  
 
1.1.2 Data types 

 

Data types in MS Access 2010 

Data type  Explanation  

Text: Data that does not need calculations and is not Date/Time 

Memo: Long alphanumeric text, such as a comment 

Number: Numbers used for calculations 

Date/Time: Used for date and time 

Currency: Money values 

Yes/No: Used when only one of two values can be selected, such as Yes/No or 

True/False  

OLE Object: Used to attach an object such as a spreadsheet or picture that will automatically 
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Data types in MS Access 2010 

(Object Linking 

and Embedding) 

update in the database when the source data changes 

Hyperlink: Used to store a link to another file 

Attachment: Used to attach a file. More than one file can be added 

Lookup Wizard: Creates a field that allows you to choose a value 

AutoNumber: Numbers automatically added when a new record is entered 

Calculation: A field that holds the answer to a calculation 

 

1.1.3 Field properties 

Field properties control what a data type does and how it appears.  
 

Field properties  

Field property What the field property does 

Field size When you choose a data type, the application creates space in memory. 
Sometimes you do not need to use all the space created. You can change the 
field size so that you do not waste space. 

Format This property controls how data displays in a field. 
The Number and Currency data types have special formats you can use to 
control how numbers are displayed. They are General Number, Currency, Euro, 
Fixed, Standard and Percent. 
The Date/Time data type has special formats you can use to control how date 
and time data is displayed. They are General Date, Long Date, Medium Date, 
Short Date, Long Time, Medium Time and Short Time. 
The Yes/No data type has three formats. They are True/False, Yes/No and 
On/Off. 

Decimal places The Number and Currency data types allow you to set the decimal places 
needed. 

Caption This property changes the display of the field name in Datasheet View. It will not 
change the field name in Design View. 

Default value If you put a value in this property, it will display automatically in the field in 
Datasheet View. 

Required This property makes sure that the field always has data in it. 
Indexed This property tells the application to create an index using the data in this field. 

(An index makes searching and sorting faster.) 
Text align This property controls how the data is lined up (aligned) when it is displayed. 
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1.2 Working with tables 

 

How to work with tables  

Task  Steps to take 

Add a field to a 
table 

Enter data in the cell below the Click to Add column header. Right-click in the 
column and rename the column to the name you want. 

Delete a field Select the column and press Delete on the keyboard. 
Add a record Enter the data in the bottom row of the table. 
Delete a record Select the record and press Delete on the keyboard. 
Create a primary 
key 

Set the primary key in Design View by right-clicking in the field and selecting 
Primary key. Or select the Design tab on the ribbon and click on the Primary Key 
icon in Design View. 

Sort information In Datasheet View, place the cursor in the field to sort by, click on the Home tab 
and click on the Ascending or Descending button in the Sort & Filter group. 

Remove a sort In Datasheet View, move to the Home tab. In the Sort & Filter group, click on 
Remove Sort. 

Filter information In Datasheet View, place the cursor in the field you want to filter by. Click on the 
Home tab on the ribbon and then click on the Filter button in the Sort & Filter 
group. Check to boxes with the values you want to filter by.  

Remove a filter Click on the Toggle Filter button in the Sort & Filter group. 
Change a field’s 
data type 

In Datasheet View, select the field. Click on the Fields tab on the ribbon and then 
click on the Data Type list arrow in the Formatting group. Select a data type. 

Edit data in a 
table 

Change any data in the table by typing over it in Datasheet View.  

 

1.3 Working with queries 

 Create a query:  
 Click on the Create tab and select the Query Wizard. Select Simple Query Wizard.  
 On the drop-down menu, choose the table you need.  
 Select the fields, and click on Next.  
 Type in a name for your query, and then click on Finish. 

 Display fields:  
 To display a field in a query, ensure there is a tick mark for that field in the Show row.  
 If you do not want a field to display in a query, remove the tick mark. 

 Criteria:  
 When you want to select only some of the records, use the Criteria row to control what 

will be selected.  
 The application compares the information you enter here with the value in the field.  
 If the value matches the criteria, the field is selected to be displayed.  
 Datasheet view is where the data is displayed while Design is where the fields and 

data types are viewed.  
 Use the Home tab to switch between views. 
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Examples of criteria  

Example of criteria Explanation 

Like “Brown” The value in the field must match exactly 

Like “B*” The value must start with the letter ‘B’, followed by any number of any 
characters 

Like “L?” The value must start with the letter ‘B’, followed by one character  

Like “*s” The value must end with the letter ‘s’, with any number of any characters in 
front 

Like “?d” The value must end with the letter ‘d’ with any one character in front 

Not “Dan” The field can have any text value, other than ‘Dan’ 

“Blue” or “Red” The value must be equal to ‘Blue’ or to ‘Red’ 

1000 The value must match exactly 

#24/2/2002# The date must be 24 February 2002 

Between #2/1/2001# 
AND #20/10/2010# 

The value must be a date between 2 January 2001 and 20 October 2010 

<Date() The value must be a date before current date 

<#24/2/2002# or 
>#24/4/2004# 

The value must be a date before 24 February 2002 or after 24 April 2004 

200 or 250 The value must be equal to 200 or 250 

Between 50 and 100 The value must be between 50 and 100 

<30 or >80 The value must be less than 30 or greater than 80 

 

1.3.1 AND, OR, NOT logic 

 AND: If you place two criteria on the same line, the application selects only the records 
where there is a match on BOTH criteria. 

 OR: If you place one criterion on the Criteria line, and one criterion on the OR line, the 
application selects records that match EITHER criterion. 

 NOT: If you place a NOT operator in front of any criterion, the application selects records 
that have any values other than the value specified. 
 

1.4 Working with forms 

 You can use the form wizard to create a form:  
 On the Create tab in the Forms group, select Form Wizard.  
 Once the form wizard has started, choose the table you need and then select the fields 

you want to display in the form.  
 Choose the layout for the form and give the form a title. 
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1.5 Working with reports 

 Create a report:  
 To use the report wizard, select the Create tab and click on the Report Wizard icon in 

the Reports group.  
 Select the table you need and then select the fields you want on the report.  
 Choose the way the information must be grouped and/or sorted by clicking on the 

arrow.  
 Choose the layout you like and the page orientation (portrait or landscape).  
 Finally, give the report a title. 

 Display page headers and footers, and report headers and footers:  
 Right-click anywhere on the report and select whether you want to view the page 

header, page footer, report header and/or report footer. 
 Calculations in reports:  

 We can use reports to analyse data. We use calculations to do this. Calculations are 
usually done at the end of a report by using the report footer. Calculations can also be 
done in groups in a group footer. 

Examples of criteria  

Function 

name 

Explanation Example 

SUM Calculates the total values in the field called ‘Owing’ =Sum([Owing]) 

AVG Calculates the average value in the field called 
‘Donation’ 

=Avg([Donation]) 

MIN Displays the lowest value in the field called ‘Donation’ =Min([Donation]) 

MAX Displays the highest value in the field called ‘Donation’ =Max([Donation]) 

COUNT Displays the total number of records that have a value in 
the ‘Name’ field 

=Count([Name]) 

PAGE Displays the page number =[page] 

DATE Displays the current date as it is set on the computer =Date() 

NOW Displays the current date and time as it is set on the 
computer 

=Now() 

ROUND Rounds off to the specified number of decimal places. 
The example shows how to round off to two decimal 
places 

=Round(Avg([Donation]),2) 
 

 
1.6 Importing and exporting 

 Import:  
 Click on the External Data tab on the ribbon.  
 In the Import group, click on the type of file you want to use. Follow the instructions. 

 Export:  
 Click on the External Data tab on the ribbon.  
 In the Export group, click on the type of file you want to use. Follow the instructions. 
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1.7 Conditional formatting 

 To change the way information looks on a report or form, first select the Text box or 
Combo box.  

 On the Format tab in the Control Formatting group, click on the Conditional Formatting 
button. 
 

2 Grouping in reports 

 We use grouping to present the data in a report in a more organised way. Grouping 
combines fields that contain the same value. 

 Select the field to use to group the report. When you click on Grouping Levels, you will 
see more grouping options, for example grouping intervals. 

 You can add grouping to an existing report too. First, switch to Design View and then 
click on the Group and Sort icon in the Grouping & Totals group on the Design tab. 

3 Group headers and footers 

When you group a report, you can use group headers and group footers to display additional 
information such as group summaries, additional text and calculations. 
 

4 Calculations in groups 

 If you want to calculate something separately for a specific set of records, you have to 
insert a calculation in a group.  

 The group combines the records that must appear together, and then forces the calculation 
to use only those records in that group. 

 If you use the group header, the calculation will display before the group. 
 If you use the group footer, the calculation will display after the group. 
 
4.1 Important points to remember 

 Where you insert the calculation will control what records the application uses in the 
calculation. If you put the calculation in the report header or footer, all the records are 
used. If you put the calculation in the group header or footer, only the fields that 
belong to the group are used in the calculation. 

 You must spell the field name correctly, and you must place the field name in square 
brackets. 

 The calculation must suit the field type. For example, you cannot use the SUM or AVG 
function for a text field. 

 You must type calculations in text boxes. 
 You must start all calculations with an equal (=) sign. 
 Add a suitable label to describe the calculation. 
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5 Calculations in queries 

 If you want to calculate something for every record, you will need to add the calculation in 
the query. Create a new field with the calculation in it. 

 To add a calculation in a query, switch to Design View first. Move to a new column, type 
in the new field name followed by a colon, and then type in the calculation. If you 
need to use a field name in the calculation, you must put it in square brackets. 

 To change the format of the calculation, right-click in the cell and choose Properties, to 
make the property sheet visible. Now move to Format and select a suitable format 
from the options available. To change the decimal places, move to Decimal Places and 
choose the one you want. 
 

Examples of calculations in queries  

Description Calculation in a query 

To calculate 14% VAT and add it to the value in 
the field 

VATInclusive:([Price]*14/100)+[Price], or 
VATInclusive:([Price]*0.14)+[Price], or 
VATInclusive:[Price]*1.14 

To calculate 15% discount and subtract it from 
the value in the 
field 

DiscountedAmount:[Price]−([Price]*15/100), or 
DiscountedAmount:[Price]−([Price]*0.15), or 
DiscountedAmount:[Price]*0.85 

To add the values in two fields together SellingPrice:[CostPrice]+[Profit] 

To divide the value in one field by the value in 
another field 

AveragePayment:[TotalAmount]/[NumberLearners] 

To multiply the value in one field by the value in 
another field 

TotalCost:[Units]*[Price] 

To calculate 10% of a value Increase:[Salary]*0.1 

To calculate the percentage where a mark is out 
of 60 

PercentageMark:[Mark]/60*100 or 
PercentageMark:[Mark]/0.6 

 

6 Adding fields in reports 

If you have already created a report using the report wizard and now want to add some more 
fields, you do not need to create a new report. You can use Design View or Layout View to 
add fields to a report that already exists. 
 

7 Data validation 

 Primary key: Each record must have a unique identification field, called a primary key, so 
that the application can find a particular record. Two records cannot contain the same 
data in the primary key field. 

 Data type: The data type you choose for a field controls what data users can enter.  
 Field size: If you change the default field size to a smaller size, users will not be able to 

enter large amounts of data.  
 Field properties: Fields have additional properties that you can set. These properties 

control what data can be entered.  
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 Index: The database application uses indexes to speed up searching and to control whether 
duplicate values in an index are allowed. If the field will be used to create an index 
you can choose one of two options: Yes (Duplicates OK) or Yes (No Duplicates). 

 Lookup column: You can give users the ability to select predefined values from a list. You 
use a lookup column to do this. A lookup column is a list of entries that appears when 
the user clicks on a drop-down arrow. The user can then select any of the available 
values. 

 Input mask: The input mask guides the user by displaying a number of characters when the 
user clicks on the field. These characters show the user an example what the data 
should look like. Input masks are very helpful when entering date and time. 

 Validation rule and validation text: A validation rule is an expression (or rule) that control 
what data the user can enter in a field. Only data that suits the validation rule is 
accepted. A validation rule has validation text that is displayed to the user to tell him 
or her what data to enter.  

 Table validation: You can create a rule that prevents data entry if the data would break a 
specified rule in a table. A table validation rule can check the value of more than one 
field. 

 List box and Combo box: List and combo boxes are very similar to lookup columns. We 
use list and combo boxes in forms. They both have predefined options that they user 
can be select. A list box contains a scroll bar and a combo box has a drop-down arrow. 

 

8  Operators in queries 

A wildcard is the name we give to a character that represents a character, or a number of 
characters, in criteria. Different wildcards in criteria have different meanings. You can use 
these wildcards with a ‘Like’ operator: 
 ‘*’ (asterisk) representing zero or more characters, for example: Like “Bedroom*” 
 ‘?’ (question mark) representing a single character, for example: Like “Bedroom Bazaa?” 
 ‘#’ (number sign) representing a single digit, for example: Like “BD#9”. When you want 

to select and display records that have no value in a specific field, you need to use the 
‘Is Null’ operator. When you use ‘Is Null’ in the Criteria row, only the records with no 
value in that field will display. The opposite of ‘Is Null’ is the ‘Is Not Null’ operator, 
which displays all the records with values in that field. 
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Questions 

1 You set up a database for a company to keep record of all the computer users. 
 

FIELD NAME  DESCRIPTION  

LogInName Name of user 
ComputerNumber The number of the computer  
Password 11 characters, all uppercase, numbers included 
Department Research and Development, Accounting, Customer Service, 

Legal Department, Sales and Marketing, Advertising 
DateStarted  The date the employee started at the company 
InternetUse The amount the Internet usage amounts to 

 
1.1 Indicate the most appropriate data types for all the fields.  (6) 
1.2 Provide the characters of the input mask for the Password field.  (3) 
1.3 Briefly describe the steps to create a combo box for the Department field.  (5) 
2.1 You were asked to create a form. Briefly describe what the purpose of a form is. (2) 
2.2 The following was entered as criteria for a query:  

“Accounting” and “Advertising”  
Briefly describe what the problem with this criterion is  
and why it will not give a result. (2) 

2.3 The following calculation was entered in the group footer:  
=SUM[InternetUse]) 

2.3.1 What is the purpose of a group? (1) 
2.3.2 By what field would you group the report? (1) 
2.3.3 Explain what this calculation will calculate in the group footer. (2) 
3 Correct the following calculation in the query:  

=Added InternetUse:{InternetUse}*1.14 (3) 
TOTAL MARKS [25] 
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Answers 

 

1.1 LogInName – Text  

 ComputerNumber – Number  

 Password – Text   

 Department – Text/Combo box/List box  

 DateStarted – Date/Time  

 InternetUse – Currency  (6) 

1.2 >AAAAAAAAAAA (correct character) (12 characters) (12 characters) (3) 
1.3 Text data type   

 Select Lookup Wizard  
 Select “I will type in the values that I want”  
 Click on Next  
 Enter the values in as rows  
 Click on Next   
 Enter a label for the lookup field  

 Click on Finish  (5) 

2.1 A form is a user-friendly  way to input data in a table (2) 
2.2 A value can either be Accounting OR Advertising. 

No record contains BOTH the values Accounting AND Advertising in the same field 
 
(2) 

2.3.1 Grouping combines fields that contain the same value. (1) 

2.3.2 Department  (1)   

2.3.3 This calculation will add up all the InternetUse amounts separately for each group. (2) 

3 AddedInternetUse:[InternetUse]*1.14  (3) 

  TOTAL MARKS  [25] 
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Chapter 5 Spreadsheets 

Overview 

 

This chapter reinforces and consolidates Grade 10 and 11 spreadsheet knowledge and skills.  
 
Unit 1 (Formulas and functions) explains more complex functions like VLOOKUP and the 
nested IF function, as well as variations of functions that you should know such as 
ROUNDUP and ROUNDDOWN, which are based on the ROUND function. You will 
combine basic functions such as SUM and AVERAGE with ROUND and work with date and 
time calculations. 
 
Unit 2 (Text functions) continues with new text functions such as LEFT, RIGHT, MID, 
CONCATENATE, LEN, VALUE and FIND.  
 
Unit 3 (Solve problems with functions and charts) You will learn about applying your 
spreadsheet skills to solve problems you may encounter, as well as more intricate chart 
techniques allowing you to edit, format and change charts. 
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Unit 1 Formulas and functions (Term 1) 

1 Reinforce content, concepts and skills 

This section provides an overview of the work learnt in Grades 10 and 11. 
 
1.1 Overview of spreadsheets 

 Spreadsheets contain cells arranged in columns and rows. 
 Spreadsheet files are also called workbooks, an individual sheet within a workbook is a 

worksheet. 
 Each cell has a cell reference, or cell address which made up of the the letter of the column 

and the number of the row, to identify its place in the spreadsheet. For example cell A1 
A1 is column A and row 1. 

 Spreadsheets can store different types of data such as numbers and text. 
 Row height and column width can be adjusted by right-clicking on the row number or 

column letter. 
 Spreadsheets work with different types of data. Cells simply need to be formatted with the 

appropriate data types. 
 
Examples of data types 

Type Explanation Examples 

General Has no specific format Computer, Office 2010 
Text Numbers not to be used in calculations Student number  
Number Used for the general display of numbers 1,3333 
Time Can be displayed using different separators 09:45 or 09h45 
Date Can be displayed using different options 22 March 2015 or 22/03/98 
Currency Numerical value shown as currency such as South African 

Rand 
R5.70 

Accounting Lines the currency symbol and decimal point up R    5.70 
R    3.35 

Percentage Multiplies the value of a cell by 100, displays the result as a 
% 

45 is displayed as 4500% 

Custom Allows you to specify the format of dates, times and other 
values as required 

dd/mm/yy or dd/mmm/yyyy 
or other variations. 

 
1.1.1 Basic calculations and operators 

 Formulas are used to add (+), subtract (-), multiply (*) and divide (/). 
 Every formula begins with an equals (=) sign. 
 Calculations are done in the order of brackets first, then division and then multiplication, 

then addition and subtraction. 
 
1.2 Functions 

 A function is a preset formula in a spreadsheet that starts with an equals sign (=) followed 
by the function name and the formula to perform a specific calculation. 

 Functions can be typed in, or inserted using the Insert Function feature. Alternatively use 
the Functions Library. 
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 Functions from Grade 10 and 11 include: 
Examples of functions (that you should already be familiar with)  

Function Name Purpose Example 

SUM Calculates the total of a range of numbers =SUM(A3:A8) 
AVERAGE Calculates the average of the numbers in a 

specified cell range 
=AVERAGE (A3:A8) 

MIN Finds the smallest value in a specified cell 
range 

=MIN(A3:A8) 

MAX Finds the highest value in a specified cell 
range 

=MAX(A3:A8) 

COUNT Finds the total number of cells that contain 
a numerical value in a specified cell range 

=COUNT(A3:A8) 

TODAY Returns the current date as set on the 
computer 

=TODAY() 

RAND Generates a random number each time the 
function is calculated 

=RAND() 

MODE Returns the value that occurs most often in 
the specified range 

=MODE(A3:A8) 

MEDIAN Returns the middle value of the values in 
the specified cell range  

=MEDIAN(A3:A8) 

SMALL Finds the smallest specified number in a 
range 

=SMALL(A3:A8,3) 

LARGE Finds the highest specified number in a 
range 

=LARGE(A3:A8,4) 

COUNTIF Finds how often specific criteria occurs in a 
cell range 

=COUNTIF(A3:A8,”Grade12”) 

COUNTA Finds the number of cells that contain text 
in a specified cell range 

=COUNTA(A3:A8) 

COUNTBLANK Finds the number of blank cells in a 
specified cell range 

=COUNTBLANK(A3:A8) 

SUMIF Calculates the total figures in a cell range if 
a specific criteria is met 

=SUMIF(A1:A6,”GRADE12”,B1:B6) 

ROUND Rounds figures off to a required number of 
decimal places 

=ROUND(A1,3) 

POWER Finds the result of a number raised to a 
specific power 

=POWER(A1,2) 

IF  Tests if a specified criterion has been met 
and provides one of two actions based on 
the result 

=IF(B3>40,”Pass”,”Fail”) 
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1.2.1 Error indicators 

Error indicators reveal a spreadsheet problem with a function in the spreadsheet. 
 
Error indicators, why they appear and solutions to the problem 

Indicator Reason Solution 

##### Column is not wide enough to display the 
contents 

Widen the column 

#NAME! Incorrect function name in formula (typing 
error or unknown function) 

Check spelling of function names in the 
formula 

#DIV/o! Formula attempts to divide by 0, which is 
not possible in mathematics 

Find and correct the error in cell reference 
or cell contents 

#REF! The cell reference in the formula is no 
longer valid (that cell was deleted) 

Change the cell reference to refer to the 
correct cell 

#N/A Formula refers to a cell that is not available 
anymore 

Correct the cell reference 

#VALUE! Incorrect value used in the cell (for 
example, a text value being multiplied) 

Correct the cell value or cell reference 

#NUM Invalid number in a formula (for example, a 
negative instead of a positive number) 

Correct the value in the relative cell 

#NULL! Cell references in a function are not 
correctly separated (for example operator is 
not placed between two cell references) 

Separate the cell references by adding the 
appropriate operator or colon 

Circular 
Reference 
Warning 

Indicates the destination cell for a formula is 
used in the calculation of the formula 

Accept the warning if it is correct or change 
the cell reference in the formula or alter the 
destination for the formula 

 

1.3 Charts or graphs 

Charts are used to display spreadsheet data in a visual format. 
 
Chart types and their uses 

Chart type Use and description 

Pie chart Used to represent data as percentages that add up to 100% 
Example: Show sales of various products in relation to the total 

Column/Bar chart Used to compare values or items 
Example: Compare CD sales over a period of time, or compare voting results 

Line chart Used to display trends over a period of time 
Example: Track increases or decreases in CD sales from 2010-2013 

Scatter chart Used to show relationships between two pairs of data 
Example: Compare rainfall in KZN to rainfall in Gauteng 

Area chart Used to show changes in sets of data over a period of time 
Example: Show increases in temperatures attributed to global warming 

 
  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 69 

1.4 Working with spreadsheets 

There are tools available to adapt spreadsheets to your own needs. 
 
1.4.1 Cell referencing 

 Relative cell references change each time a formula is copied to a different cell. 
 Absolute cell references always refer to the same cell wherever the formula is copied to. 
 To make a cell reference absolute, highlight the reference and then press the F4 key. 

Alternatively place the $ symbol before the column and row cell reference, for 
example, $A$2. 

 A column on its own may be referenced as absolute, for example $A2, in the same way as 
a row can, for example A$2. 

 
1.4.2 Auto Fill options 

Include: Copy Cells, Fill Series, Fill Formatting Only and Fill Without Formatting. 
 
1.4.3 Importing and exporting data 

 Data can be imported from a text file or a database into a spreadsheet. 
 Spreadsheet data such as a Chart can be pasted in a word processing document. 
 A chart pasted into a word processing document can be linked to the spreadsheet data by 

using the Paste Special feature. 
 This means the pasted chart in the word processing document will be updated when 

changes are made to the spreadsheet data. 
 
1.4.4 Moving and copying worksheets 

 The order of the spreadsheets can be changed by dragging and dropping the worksheets 
into order that you choose. 

 
1.4.5 Linking cells and formulas between sheets 

 To link cells and formulas between sheets, type an equals sign (=) into the cell where you 
would like to place the final answer. 

 Then click on the cell containing the data followed by the relevant mathematical operator, 
then the next cell and so on until all the required cells have been linked. 

 Complete this by pressing the Enter key. 
 
1.4.6 Headers and footers 

Date and time, file name, page number, number of pages and file path are some of the data 
that can be inserted into the Header. 
 
1.4.7 Protecting data 

Data can be protected by adding a password to open or modify cells, a worksheet or 
workbook. 
 
1.5 Printing 
 Options are available for printing a selected portion of data, a worksheet or an entire 

workbook. 
 Exercise caution when printing to avoid wasting paper and ink. 
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1.5.1 Print area and sheet options 

 Setting the Print area allows you to print pre-selected cells without having to select the 
cells each time you print. 

 Print gridlines can be selected for printing. This means you do not have to add borders to 
the work for printing purposes. 

 

2 More-complex functions 

 Use more complex functions for greater analysis and decision-making assistance. 
 These are also useful as a time-saving method for working with large volumes of data. 
2.1 Nested IF functions 

 The IF function is used to test a condition. 
 Different criteria and operators can be used within the nested IF function such as greater 

than (>), less than or equals to (<=) or other variations. 
 Remember: 

 The function must be typed in. The Insert Function feature cannot be used in this 
instance. 

 For every opening bracket there must be a closing bracket. 
 Any text typed into the function must be included between quotation marks. 
 A result can be left empty by typing in only quotation marks “” 

 
2.2 The vertical lookup function (VLOOKUP function) 

 VLOOKUP is used to return a value from a range in a table in the same worksheet or 
another worksheet within the workbook. 

 
2.2.1 Using the VLOOKUP function 

 This function has four arguements to it: 
 Lookup_value – the value you wish to insert in the specified cell. 
 Table_array – the cell range where the required data is stored. 
 Col_num_index – the location of the column where the data must be taken from. That 

is the first, second, third etc column. Key in 1, 2 or 3 etc not A, B, C. 
 Range_Lookup – type False if an exact data match is required or True for the closest 

data match. 
 

2.2.2 The #N/A error indicator in the VLOOKUP function 

The error may occur if: 
 True is inserted in the Range_lookup field instead of False (and vice-versa). 
 A relative cell reference is used where an absolute cell reference is required. This usually 

occurs in the Table_array. 
 Data in the Lookup_value does not match data in the reference table. 
 
2.3 ROUND function 

 The ROUND function is is used to round a number off to a required number of decimal 
places. 

 Values of .5 and higher are rounded up while those below .5 are rounded down. 
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 Unlike increasing or decreasing decimal places this function rounds the number off rather 
than just changing the number of decimal places displayed. 

 ROUNDUP rounds the figure away from zero. 
 ROUNDDOWN rounds the figure towards zero. 
 

2.4 Combining ROUND with other functions 

 The ROUND function can be combined with functions such as SUM or AVERAGE. 
 ROUND is typed first, then the other function, followed by the cell range and the number 

of places to round off to. 
 Example: =ROUND(SUM(B2:B4),0) 

 

3 Basic date and time calculations 

 The regional settings for Windows will influence how the dates and times will be 
displayed when you format them. 

 For example, you may use forward slashes to enter a data value for a date field as 
14/02/2014, but when you apply the General Date display format, it may display 
differently depending on the regional setting for Windows.  

 
3.1 Customising the date format 

 Dates can be formatted as either long date or short date. 
 You can also customise the date format by customising the formatting of the date by using 

the Custom option on the Number menu in the Home Ribbon. 
 Dates can be formatted with or without the – or / separators. 
 The Day, Month, Year sequence is the most commonly used in South Africa. 
 
3.2 Using dates in calculations 

 To calculate the difference between dates as days you subtract one cell from another. 
 To format the number of days as years the result must be divided by 365.25. 
 An example of this would be =(A2-B2)/365.25. 
 
3.3 Using time in calculations 

 Data representing time can be formatted as hh:mm:ss or before midday (AM) and after 
midday (PM). 

 Subtracting one cell from another produces an answer in days. 
 The cell reference should be multiplied by 24 and the cell formatted as Number. 
 An example of this would be =(A2-B2)*24. 
 
3.4 Date and time functions 

 Simple time and date functions include: 
 =TODAY() – inserts the current date into a cell. 
 =NOW() – inserts the current date and time into a cell. 
 =DATE(Year, Month, Day) – combines the data from 3 different cells into one cell. 
 =TIME(Hour, Minute, Second) – combines the data from 3 different cells into one 

cell. 
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Unit 2 Text functions (Term 2) 

1 Revise content, concepts and skills 

Regular and repeated practice is important to master and maintain your skills. 
 

2 Working with text 

 Most functions are designed to work with and manipulate numbers. 
 Text functions will return a value which is converted to text in a specified number format.  

 
Summary of text functions 
Function Purpose Example 

LEFT Extracts and returns the left most characters from a 
text string, for example if you want only the left most 
3 letters of a surname to appear it will return ADA for 
ADAMSON  

=LEFT(A1,3) 

RIGHT Extracts and returns right most characters from a 
text string, for example if you want only the right 
most 3 letters of a surname to appear it will return 
SON for ADAMSON  

=RIGHT(A1,3) 

MID Extracts a substring from a string, starting at any 
position that you specify. For example, in the 
surname ADAMSON the letters AM can be extracted 
using this function. 

=MID(A1,3,2) 

CONCATENATE Joins or combines the contents of different cells into 
one cell. For example, the Title in cell A1 is Mr, the 
Name in cell B1 is Sam and the Surname in cell C1 
is Smith. The result placed in one cell is Mr Sam 
Smith 

=CONCATENATE(A1,B1,C1) 

LEN Returns the length of a string, that is, the number of 
characters in a cell. For example the word 
ADAMSON returns a result of 7 

=LEN(A1) 

VALUE Converts a value that represents a number into a 
number OR Converts a text argument to a number 
If text is not a number, the Value function will return 
#VALUE!. For example if the number 50 is imported 
from another application the function will convert it to 
a number format that the spreadsheet recognises 

=VALUE(A1) 

FIND Returns the location of a string of text from a 
specified cell 
Note: FIND is case sensitive. For example letters 
SON can be found within the text ADAMSON 

=FIND(Text,A1) 
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2.1 LEFT, RIGHT and CONCATENATE 

 The LEFT function is useful for extracting the leftmost characters from a string of data in 
a cell. 

 The RIGHT function works exactly like the RIGHT function but from the right. 
 The CONCATENATE function combines strings of data from different cells into one cell. 
 LEFT or RIGHT can be combined with CONCATENATE.  

An example of such a combination could look like:  
=CONCATENATE(B2,RIGHT(C2,4)). 

 
2.2 LEN, VALUE and FIND functions  

 
2.2.1 LEN and VALUE functions 

 LEN finds the length of the data in a string. 
 This function can be applied to text and numerical data. 
 VALUE allows for data representing numerical data to be formatted as a Number. 
 
2.2.2 FIND function 

 This function finds a specific string of text within a function. 
 The exact position of the string within the cell is easily identified. 
 Remember: 

 This function is case sensitive. 
 You cannot use a Wildcard (*) in this function. 
 A #VALUE! error is returned if the value being sought is not contained in the cell. 
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Unit 3 Solve problems with functions and 

charts (Term 3) 

1 Further revision of content, concepts and skills 

Ensure you familiarise yourself with newer content from Grade 12 and that you are able to 
apply these skills with ease. 
 

2 Use functions to solve problems 

 

Summary of functions categories used in CAT 
Function Category Example of function 

Logical IF 
Text LEFT, RIGHT, MID, CONCATENATE, LEN, 

VALUE, FIND 
Date & Time TODAY, NOW, DATE, DAY, MONTH, YEAR 
Lookup & Reference VLOOKUP 
Math & Trig POWER, RAND, ROUND, ROUNDDOWN, 

ROUNDUP, SUM, SUMIF 
Statistical AVERAGE, COUNT, COUNTA, COUNTBLANK, 

COUNTIF, LARGE, MAX, MEDIAN, MIN, MODE 

 
 Functions can be used to solve any problem suitable to a spreadsheet. 
 Problems to which a spreadsheet solution can be applied include: 

 Calculating learner marks 
 Analysing survey results 
 Monitoring data from scientific experiments  
 Analysing weather patterns  
 Calculating salary payments and scales 

 
 When using a spreadsheet as a tool to solve a problem remember: 

 Think about what you would like the spreadsheet to solve. 
 To plan what data types you will be working with. 
 To decide what data will need to be collected in order to solve the problem. 
 Consider what functions will be useful in assisting you to solve the problem. 
 Plan how you will present your solutions to the problem. 

 

3 Advanced combinations of functions 

 More advanced combinations of functions can be used to provide information useful for 
decision-making. 

 Such combinations include CONCATENATE with LEFT or RIGHT, adding or 
multiplying SUMIF and COUNTIF functions. 

 

4 Edit, format and use charts 

More advanced chart features can be utilised to improve the effectiveness of the chart. 
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4.1 Editing data labels 

 

How to change titles and labels 
To change titles To change labels 

 Click on the chart or axis title 
 Highlight the existing title 
 Type over the data 
 Click off the title 

 Click on the data label (the Chart Tools Ribbon will be visible). 
 Select the Data category from the Design tab. 
 Click on Select Data. 
 Choose a label from the Select Data Source dialogue box (see 

Figure XX below) For example, Series1. 
 Click on Edit. 
 Type the new label name in the Series name box. 
 Click OK and repeat steps 4-6 if there are other labels to 

change. 
 Click OK again to close dialogue box and save the changes. 

 
4.2 Changing scales on the axes 

 Numerical intervals are displayed on the vertical axis. 
 Text intervals are displayed on the horizontal axis. 
 The space between each point on an axis is called an interval. 
 The Format Axis option allows you to make changes to the scale. 
 The minimum and maximum value are automatically determined by the application when 

creating a chart but these can be further manipulated manually. 
 Tick marks on the axis can be changed by adjusting the minor and major unit in the Axis 

Options menu. 
 
4.3 Creating stacked bar and column charts using a graphic 

 A stacked chart allows you to group similar data in one chart. 
 Stacking shows the relationship between individual items.. 
 
4.4 Using charts for specific scenarios 

 A pie chart can be used to compare different values adding up to 100%. 
 A line chart can be used to compare Grade 12 year-end pass rates over several years. 
 A scatter chart can be used to show the difference between pass rates for boys and girls. 
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Questions 

Open the spreadsheet SG_Excel and do the following: 
Refer to Sheet 1 

1 In the spaces provided calculate the total number of learners for each learning area.  (2) 
2 Use a suitable function in column W to determine a Grade 12 learner’s subject status.  

The criteria are: 
A learner taking more than seven subjects should state ‘Monitor’. For a learner taking  
seven subjects only the cell should state ‘Acceptable’ and if a learner is scheduled for  
fewer than seven subjects it should state ‘Review’. Repeat this for Grades 10 and 11. (5) 

3 Create a learner number for each Grade 12 learner in column B. The code should be 
the Grade, the first three letters of the learner name and last three letters of the learner 
surname. For example: 12Jacith for Jack Smith.  (3) 

4 Adjust the page layout to ensure that the data for each grade will print on a separate 
landscape page.  (2) 

Refer to Sheet 2 

5 Use a function to insert today’s date in column H. Format columns G and H using  
the dd/yy/yy format.  (2) 

6 Use an appropriate formula in column I to determine the length of time each learner  
has spent at the school. Ensure this is reflected in years and not as days.  (2) 

7 A registration fee is charged for each learner joining the school (column D). Calculate  
the total for each class in cells M2:4 and then provide an overall total in cell M5. (4) 

8 Format the data in column D as a suitable data type.  (1) 
9 In cell M7 use a function to determine the second largest amount received by a class. (1) 
10 After grade 12 the school refund part of the registration fee. This amount is  

determined by subtracting the registration fee from 5% of the total registration fee  
amount received. Insert your formula in cell J2 and copy it down for all learners. (3) 

11 Use a suitable formatting technique to highlight the two lowest refund amounts.  
Format these in a red font with blue shading.  (2) 

Refer to Sheet 3 

12 Create a chart which will compare each class’s registration fee for a particular year. The 
chart must display the years 2009 – 2013 (do not use a line chart). Be certain to add 
suitable titles, axes labels etc., and ensure that the vertical axis is formatted to show a 
minimum value of 28000 and a maximum value of 38000 with increments of 1000. (3) 

TOTAL MARKS: 30 
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Answers 

1 Sheet1 
Cell E20: =SUM(E3:E18)repeated through to cell T20  
and the same in rows 33 and 47.  (2) 

2 Cell W3: =IF(V3>7,"Monitor",IF(V3=7,"Acceptable",IF(V3<7,"Review"))) 
Repeated for Grade 10 data and Grade 11 data  
 (5) 

3 Cell B3: =CONCATENATE (A3,LEFT(C3,3),RIGHT(D3,3))  (3) 

4 Page break lines adjusted so only one sheet fits per page 
Page orientation changed to landscape 

(2) 

5 Sheet2 
Cell H2: =Today(), copied down 
Cells G and H formatted as dd/mm/yy 

(2) 

6 Column I: (H2-G2) /365.25 (2) 

7 Cell M2: =SUMIF(B2:B36,"j",D2:D36) 
Formula used in cells M3: M4 
 
Cell M4: =SUM(M2:M4)  

(4) 

8 Column D formatted as Currency.  

(1) 

9 Cell M7: =LARGE(M2:M4,2)  

(1) 

10 Cell J2: =$M$5*5%-D2 

(3) 

11 Column J Conditional Formatting applied: 
Rule: Top/Bottom Rules applied – bottom 2 red font on blue fill (2) 

12 Sheet3  
Stacked Column Chart (not line chart)  
Titles and axes suitably labelled  
Vertical axes increases in increments of R20 000 (3) 

TOTAL [30] 

 
 

  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 78 

Chapter 6 Word Processing 

Overview 

Unit 1 (Referencing, reviewing, pagination and importing data) This chapter consolidates 
Grade 10 and 11 word processing knowledge and skills. You will also learn to insert 
bookmarks and how to hyperlink to bookmarked locations. We focus on the reviewing tools 
and the track changes feature. Line breaks and pagination options such as widow and orphan 
control and the importing of data collected using electronic forms are explained.  
 
Unit 2 (Mail merge and file management) You are familiar with mail merging and how to 
create and print personalised labels, envelopes and letters. You will practise the mail merge 
feature using data from different data sources. We explain advanced file management and how 
to prepare a document for electronic distribution. We look at advanced page layout and styles 
as well as the integration with other applications such as databases and spreadsheets. 
 
Unit 3 (Advanced document styles and integration) You will reference and manage sources, 
add a table of contents, insert footnotes and endnotes and add a caption to a picture. We revise 
hyperlinking and use the paste special option to link or embed objects in different 
applications. We reinforce reviewing and proofreading features, page and document layout, 
bulleted and numbered lists, tabs and tables, and the design and creation of electronic forms.   



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 79 

Unit 1 Referencing, reviewing, pagination and 

importing data (Term 1) 

1 Bookmarks 

Instead of scrolling through the document to find the text, you can go to it by using the 
bookmark name. 
 
1.1 Working with bookmarks 

 Select the text or item to which the bookmark will refer. 
 From the Insert tab, Links group, click Bookmark. 
 At the Bookmark dialogue box under Bookmark name, type a name for your bookmark, 

then click Add. 
 

1.1.1 View the bookmarks 

Click File tab, Options button, Advanced. Under Show document content, select the check 
box at Show bookmarks, and then click OK. 
 
1.1.2 Delete a bookmark 

At the Bookmark dialogue box, click the name of the bookmark that you want to delete, and 
then click Delete.  
 
1.1.3 Go to a bookmark 

At the Bookmark dialogue box, click the name of the bookmark that you want to revisit, and 
then click Go To. 
 
1.1.5 Use a hyperlink to go to a bookmarked location 

 In the current document, allocate a bookmark to the text or object. 
 In the same document, select the text or object that you want to display as the link.  
 On the Insert tab, in the Links group, click on Hyperlink.  
 In the Insert Hyperlink window, under Link to, select Place in This Document. 
 At the list of options, select the bookmark that you want to link to, and then click OK. 
 To go to the bookmarked location, press the Control key and click on the hyperlinked text. 

 
1.2 Cross-references 

A cross-reference is a reference from one part of a document to another point within the same 
document.  
 
1.2.1 Insert a cross-reference to a bookmark 

 Create a bookmark at a place in the document. 
 Move the cursor to the place where you want the cross-reference to appear.  
 Click the Cross-reference button at the Insert tab, Links group. 
 In the Cross-reference dialogue box that appears, under Reference type:, select Bookmark 

as the type of item that the link will search for. 
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 Place a check mark at the Insert as hyperlink option.  
 At the Bookmark dialogue box, click the name of the bookmark that you want to revisit, 

and then click Go To. 
 Under For which bookmark, select the bookmark name that will be the destination of the 

link. 
 Under Insert reference to:, choose Page number as the type of text that will be displayed in 

the link. Click on Insert, and then Close. 
 

2 Reviewing and tracking changes 

2.1 Tracking changes 

The Track Changes feature keeps a record of all the changes that you make in a document. 
You can choose to accept or reject the tracked changes.  
 
2.1.1 Track the changes while you edit 

 Open the document you want to edit. 
 On the Review tab, Tracking group, click the drop-down arrow at the Track Changes 

button. Click the Track Changes option.  
 Make the changes that you want by inserting, deleting, moving and formatting text. 
 To turn off the tracked changes, click the Track Changes option.  

 
2.1.2 View the tracked changes in a document 

You can review the changes using the options on the Review tab. In the Tracking group the 
options, Show Markup and Reviewing Pane, control what you see. 
 
2.1.3 The 'Display for Review' box 

 Choose how you want to view the changes that have been made to a document: 
 Final: Show Markup: Displays the final version of the text with all the tracked changes 

and comments showing. 
 Final: Displays the final version of the text with all the suggested changes included in 

the text, but the tracked changes are hidden. 
 Original: Show Markup: Displays the original version of the text with all the tracked 

changes and comments showing. 
 Original: Displays the original version of the text before changes were made. 

 
2.1.4 The 'Show Markup' option 

 To choose what kind of markup to show in the document, click on the drop-down arrow of 
the Show Markup button. Place a check mark next to the type of change that you want 
to see in your document: 

 Comments shows comments that have been added to the document. 
 Insertions and Deletions shows what has been added, or deleted. 
 Formatting shows what formatting changes have been made. 
 Markup Area Highlight highlights the margin where balloons appear. 
 Balloons shows changes in balloons in the margin. 
 Reviewers shows which author (called a reviewer) made a change or added a 

comment. 
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2.1.5 The 'Reviewing Pane' option 

You can show changes in a document in a separate window, either at the left or at the bottom 
of the screen. Use the drop-down arrow of the Reviewing Pane button to select either 
Reviewing Pane Vertical or Reviewing Pane Horizontal.  
 
2.1.6 How to show the tracked changes 

 Click on the drop-down arrow at the Show Markup button in the Tracking group.  
 Hover the mouse over the Balloons option to open the list of markup options: 

 Show Revisions in Balloons shows deletions in balloons in the margins and insertions 
as underlined text. 

 Show All Revisions Inline shows all the changes in the document itself. 
 Show Only Comments and Formatting in Balloons shows only comments and 

formatting changes in balloons in the margin, not insertions and deletions. 
 

2.2 Accepting or rejecting tracked changes 

 To accept the tracked changes click on the drop-down arrow at the Accept button in the 
Changes group. Use the Accept button to do the following: 

 Click on Accept and move to Next to accept the current change and move to the next 
change. 

 Click on Accept Change to accept the current change. 
 Click on Accept All Changes Shown to accept all the changes in view. 
 Click on Accept All Changes in Document to accept all the changes. 
 The Reject button is next to the Accept button. Rejecting a change is similar to 

accepting one, but when rejected, the change is ignored and removed. 
 

3 Line breaks and pagination options 

Page breaks 

 The application automatically creates a soft page break once the page is full.  
 You can also insert a page break at any place in the document by selecting Page options on 

the Page Breaks drop-down menu, or the shortcut keys, Ctrl+Enter. 
 

Insert section breaks 

 Click in the document where you want the section break to be. 
 On the Page Layout tab in the Page Setup group, click on the Breaks button. 
 Click on the type of section break that you want to use:  

 Next Page starts a new page (useful for new chapters). 
 Continuous stays on the same page (useful for adding columns to a page). 
 Even Page starts the next section on the next even-numbered page. 
 Odd Page starts the next section on the next odd-numbered page.  

 
Line breaks 

Line breaks (Shift+Enter) are used in a document when you want to start a new line but not a 
new paragraph. 
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Pagination options 

 Pagination is the process of dividing a document into pages. You can control the 
pagination of a document by setting options in the Paragraph group on the Page 
Layout tab. 

 Click on the paragraph group's dialogue box launcher arrow to open the Paragraph 
dialogue box, and then click on the Line and Page Breaks tab.  
 

Widow/Orphan control 

 Widow is the last line of a paragraph that appears by itself at the top of a page. 
 Orphan is the first line of a paragraph that appears by itself at the bottom of a page. 
 To prevent widows and orphans in a document: 

 Select the paragraphs in which you want to control widows and orphans. 
 In the Paragraph dialogue box, under Pagination, select the Widow/Orphan control 

check box. Then click on OK. 
 

Prevent page breaks between paragraphs 

 Select the paragraphs that you want to keep together on a single page. 
 Under Pagination, select Keep with next, and click on OK. 

 
Keep lines of a paragraph together on a page 

 Select the paragraph that contains the lines you want to keep together. 
 Under Pagination, select Keep lines together, and click on OK. 

 
Force a page break before a paragraph 

 Select the paragraph or text that you want to appear after the page break. 
 Under Pagination, select Page break before, and click on OK. 

 

4 Import data collected using electronic forms 

4.1 Saving only the data from electronic forms 

Use these steps to create a delimited text file (where the fields are separated by a comma) 
containing data from a form. 
 Step 1: Use the Legacy Forms controls of the Control group, on the Developer tab, to 

create an electronic form. 
 Step 2: Protect the form so that a user can enter data only in the form's fields. 

 Click on the Restrict Editing button in the Protect group of the Developer tab.  
 In the Restrict Formatting and Editing task pane, under Editing restrictions, select 

Allow only this type of editing in the document. 
 Select Filling in forms from the list of editing restrictions. 
 Under Start enforcement, click on Yes, Start Enforcing Protection. 

 Step 3: Save the form as a template by clicking on the Save As option on the File tab. At 
the Save as Type drop-down list, select Word Template (*.dotx). 

 Give your file a name and then save and close the file. 
 Step 4: Locate your template file in your templates folder and fill in the form. 

 After you have filled in the form, select Options at the File tab. 
 Click on Advanced and, under Preserve fidelity when sharing this document, select the 

check box at Save form data as delimited text file.  
 Click on OK. Click on OK again to save the document as a text file. 
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4.2 Importing form data 

4.2.1 Import form data into a spreadsheet using the Text Import 

Wizard 

 Open a spreadsheet. Use the import buttons in the Get External Data group of the Data tab. 
Click on the From Text button. 

 In the Import Text File dialogue box, double-click on the text file that you want to import. 
This opens the Text Import Wizard dialogue box. 
 

4.2.2 Follow the Text Import Wizard 

 In the section Original data type, select the Delimited option. Click on Next. 
 If your data contains commas, in the section Delimiters, select Comma. Click Next. 
 In this window you can select Do not import column to skip any column. 
 Click on Finish. An Import Data dialogue box opens asking you where you want to put the 

data. You can choose any cell in the existing worksheet.  
 Click on OK to complete the import process.  

 
4.2.3 Import form data into a word processing document 

 Open a word processing document. At the drop-down arrow of the Object button in the 
Text group of the Insert tab, click on the Text from File option.  

 In the Insert File dialogue box, search All Files (*.*). 
 When you locate the file, double-click on it, and then click OK.  

 
4.2.4 Export form data to a word processing application 

 In a database, right click on the database table where the data is stored.  
 Select the option Export on the context menu, and then select Word RTF File from the 

sub-menu. This will open the Export – RTF File window.  
 Select the option to Open the destination file after the export operation is complete, and 

then click OK.  
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Question 1 

Open the file SG_6A. Make changes to the document as follows: 
1 Hyperlink the word 'Toggle' to the bookmark called 'Num_Lock'.  (2) 
2 Delete the bookmark 'num_keys'.  (2) 
3 Create a cross-reference from the name of the author, 'Sonia Pass' on page 1,  

to link to the first heading on page 3. Use the page number as the reference. (3) 
4 Switch the track changes feature on.   (1) 
5 Display the following markup in the document: Comments and all Reviewers. (2) 
6 Apply a two-column format, with a line between, to the last two paragraphs on the last 

page of the document.  (3) 
7 Control the pagination of the document as follows: 
 7.1 Prevent widows and orphans.  (2) 
 7.2 Keep headings together with their paragraphs.  (2) 
8 Import the text file SG_6B into cell A1, row 1, of the spreadsheet which is  

saved as SG_6C.  (3) 
TOTAL MARKS [20] 

 

Answers to Question 1 

1 Hyperlink on 'Toggle'  to the bookmark 'Num_Lock'. (2) 

2 Bookmark 'num_keys'  deleted  (2) 

3 Cross-reference at author name (Sonia Pass)  linked to 1st heading on page 3 
(Availability of types….) page number as reference  

(3) 

4 Track changes switched on (either at Reviewing tab or Status bar) (1) 

5 Markups selected: Comments  Reviewers  (2) 

6 Two columns applied to last two paragraphs on last page  with a line between  (3) 

7 7.1 Pagination  widow/orphan selected   
7.2 Pagination  keep with next  

(2) 
(2) 

8 Data from text file  imported into spreadsheet  in cell A1 of row 1 (3) 

TOTAL [20] 
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Unit 2 Mail merge and file management 

(Term 2) 

1 Reinforce content, concepts and skills 

You have used the different features of a word processing application to: 
 Develop documents such as letters and reports.  
 Create and print personalised documents such as labels, envelopes and letters, using the 

mail merge buttons of the Mailings tab.  
 Send documents via e-mail and from one application to another using the Save & Send 

options of the File tab. 
 Convert documents to the newest file formats, as an alternative to working in compatibility 

mode, using the Convert option of the File tab. 
 Save files in different formats such as TXT or RTF and publish documents in PDF and 

XPS formats. 
 

2 Mail merge 

Mail merge combines one document with individual details from another file to create 
multiple, personalised documents.  

 
2.1 Data source 

 A typical data source file consists of: 
 Rows that contain one record of data, such as the details of one recipient. 
 Columns that contain a category of information called a field, such as the first name of 

all the recipients. 
 The fields that you add to the main document are the field name tags for these 

categories. 
 

2.1.1 Select recipients 

You can select your recipients by entering them into a new recipient list, use an existing list, 
or import an e-mail contact list. In the following example you will select the recipients from 
an existing list. Use the buttons in the Start Mail Merge group on the Mailings tab. 
 

 Step 1: Select the mail merge document type by clicking on Letters at the Start Mail 
Merge drop-down list. 

 Step 2: At the Select Recipients drop-down arrow, click on Use Existing List. 
 Step 3: At the Select Data Source window that opens, locate the file that contains your 

data source.  
 Step 4: Write your e-mail message. To add the field name tags to your document, use the 

buttons of the Write & Insert Fields group. The field name tags are recognised by the 
brackets <<>> that mark the place for the information. 

 Step 5: Click on the double arrows in the Preview Results group to preview your letters. 
 Step 6: Complete the merge. In the Finish group, click on the Finish & Merge button and 

select the option to Print the document or Edit individual letters.  
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2.1.2 Other data sources 

 If you use a word processing document as your data source, the document should contain a 
single table.  

 You can also use any text file that has used tab characters or commas to separate data in a 
record. 
 

2.2 Merge data to a directory 

 A directory contains a printed list of names, addresses and other information. 
 The process of using a directory as your main document is the same as for any other 

document type. 
 The difference between a directory and a form letter is that the directory lists each 

recipient underneath each other with no section break separating the individual 
records. 
 

3 File management 

 The File ribbon tab in Microsoft Office 2010 replaces the Office Button in the 2007 
version of Microsoft Office. 

 The File ribbon tab gives you access to the Backstage view which contains the basic file 
management commands, such as Save, Save & Send and Options. 
 

3.1 Prepare a document for distribution 

To distribute a document means to make an electronic copy of the document available for 
others either to share and edit or to read. For example, you can distribute an electronic 
document manually using a removable storage device or you can distribute it as a web-based 
hyperlinked document. 
 
3.1.1 The Document Inspector 

 Each time you create an electronic document, metadata is automatically added to it. 
 Metadata provides information about the file, such as the name of the author and the date 

the file was created. 
 You use the Document Inspector to find and remove hidden metadata: 

 Open the document. Click on the File tab and select the Info option. 
 Under Prepare for Sharing, click Check for Issues, and then click Inspect Document. 

Click Yes to save the file. 
 In the Document Inspector dialogue box, select check boxes to choose the types of 

hidden content that you want inspected. Click Inspect. 
 If the document inspector finds hidden and personal content, the option to Remove 

All, will appear under Review the inspection results. 
 

3.2 Publish a document 

 To publish a document means to make an electronic copy of the document available for 
others either to view and edit. 

 You can choose options such as PDF or XPS to publish documents in a more compatible 
file format. 
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3.2.1 The 'Save and Send' option 

Use this option to send your document to a central location on the Internet. You can then share 
your document with other people.  
 
3.2.2 The 'Save to Web' option 

Use this option to store your documents on a Web server and use the Word web application to 
open the document in your browser. 
 
3.2.3 The 'Save to SharePoint' option  

SharePoint libraries are locations on a special type of online site where you can store and 
control how files are viewed, tracked, managed and created. 
 
3.2.4 The 'Publish as Blog Post' option 

A weblog is an informal website consisting of articles in a diary format. To create a weblog 
using a document in your word processing application, click on the Publish as Blog Post 
option. Then click on the Publish as Blog Post button.  
 
3.2.5 The 'File Types' option 

 When you create a document to share and publish, you can save the document as a 
readable file only, or as a readable and editable file. 

 These options can be accessed from the File tab, Save & Send option, under File Types.  
 

3.2.6 Changing file types 

 At Save & Send, click on the Change File Type button, to view the different file formats.  
 Under Change File Type, click on the file type of your choice.  
 Click the Save As button to open the Save As dialogue box. 
 In the Save As dialogue box, the File Name and the Save as type boxes are automatically 

changed to the new file type that you chose.  
 Click Save, then click OK. 

 

3.2.7 Creating and saving a document in a fixed format 

 Click on the Create PDF/XPS Document option, and then click on the Create PDF/XPS 
button. 

 In the Publish as PDF or XPS dialogue box, in the Save as type list, select PDF (*.pdf) or 
XPS Document (*.xps). Click on the Publish button to create the file. 
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Question 2 

1 Personalised questionnaires must be sent to specific recipients in Grade 12.  
1.1 Use the files SG_6D and SG_6E to prepare for a mail merge. 
1.2 The 'Disability' table in the SG_6E database contains the recipient list. 
1.3 The Questionnaire document is issued to recipients who have a disability. 
1.4 Sort the recipients in descending order of the Code column. 
1.5 Add the merge fields Name and Surname, for example <Name> <Surname>.  
1.6 Save this document as SG_6Merge before completing the merge. 
1.7 Save the results of the merge as SG_6Complete. (10) 

2 Use the table on page 2 of the SG_6F file and type the answers to the following:  
2.1 Why would you publish the contents of a document to a Weblog? (2) 
2.2 Why would you send a document to a central location online? (2) 

3 Remove the properties, comments and header information from the SG_6F file. (3) 
4 Mark the SG_6G file as Final to discourage readers from editing this document. (1) 
5 Save the SG_6H file in a fixed format of your choice.  (2) 

TOTAL MARKS [20] 

 

Answers to Question 2 

1 1.1 Correct mail merge document type: Questionnaire SG_6D.  
1.2 Correct data source from the Disability table in the SG_6E.accdb is used.  
1.3 Documents prepared for recipients with a disability.  
1.4 Recipients sorted in descending  order of Code column.   
1.5 Merge fields Name  and Surname  with a space between Name and Surname.  
1.6 Merge is correctly saved as SG_6Merge.  
1.7 Results of the merge correctly saved as SG_6Complete.  

(1) 
(1) 
(1) 
(2) 
(3) 
(1) 
(1) 

2 2.1. Blogging - publish content consisting of articles in a diary format, to the Web.  
2.2 To access documents from any computer  or to share documents with other people.  

(2) 
(2) 

3 Metadata document properties,  comments,  headers, deleted.  (3) 

4 SG_6G file marked as Final.   (1) 

5 SG_6H file saved in a fixed format in PDF or XPS.  (2) 

TOTAL [20] 
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Unit 3 Advanced document styles and 

integration (Term 3) 

1 Reinforce content, concepts and skills 

 You use the basic layout options on the Page Layout tab to change the overall design of an 
entire document. For example, adding Themes, adjusting and customising the page 
setup, adding watermarks, page colour and page borders to the page background, and 
inserting line and page breaks. 

 You use the basic layout options on the Insert tab to insert and format pages, tables, 
illustrations, links, headers and footers, text and symbols. 

 The Home tab incorporates all text formatting features such as font and paragraph 
changes, creating and applying styles to the document text, paste and paste special and 
editing options.  
 

2 Document styles and page layout 

2.1 Document styles 

 Click on a style in the Quick Styles gallery, in the Styles group of the Home tab, to apply a 
style to selected text. 

 Change a style set by clicking the Change Styles command and then click on the Style Set 
button. Choose a style from the list of options. 

 Change or edit an existing style by clicking on the drop-down arrow of a style in the Style 
Pane Options dialogue box. 

 At the list of options that appear, click Modify to open the Modify Style dialogue box. 
 Create a new style: 

 Open the Styles task pane and click on the New Style button at the bottom left of the 
window. 

 This opens the Create New Style from Formatting dialogue box.  
 Under Properties, type a new name for your style in the Name box. 
 Choose a Style type from the drop-down list. For example, Paragraph. 

 
2.2 Templates 

 A template is a file with a page layout, font, margins and styles that are suitable for a 
specific type of content.  

 The file type of a template is dotx which, when opened, creates a copy of itself. 
 You can create your own templates and save them for future use or you can use the 

templates available from Office.com. by clicking on New from the File tab.  
 To customise a pre-formatted template you can type your own content into the text area of 

the content controls. 
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2.3 Advanced page layout 

 Use the buttons of the Page Layout tab to change the design of a document. 
 If you want to add a Book fold to your page to create a booklet, you can customise the 

margin settings to suit your needs.  
 If you want the margins of the left page to be a mirror image of those on the right page, 

you can select Mirror margins at the page margins options. 
 For page margin options:  

 Click the drop-down arrow of the Margins button, Page Setup group, to open the Page 
Setup dialogue box.  

 On the Margins tab, under Pages, click the drop-down arrow.  
 When you modify the margin settings, you are given the option to change the margins 

at the Inside and Outside boxes in the Margins section.  
 

2.3.1 View and adjust the document structure 

 On the View tab, in the Show group, select the Navigation Pane check box to open the 
Navigation Pane. 

 In the Navigation Pane you can: 
 Reorganise your documents by dragging and dropping headings.  
 Delete, cut, or copy headings and their content. 
 View Thumbnail images of the document pages. 
 Browse through your document by its headings (to do this you must have applied 

styles to your headings). 
 Show or hide the subheadings under a heading by clicking on the triangle next to the 

heading. 
 Right click on a heading to promote, demote, add or delete a heading. 

 

3 Techniques of integration with other software 

Integration exchanges information between different but compatible applications, such as 
those that form part of the same Office Suite. 
 
3.1 Hyperlinking 

 To link to an object in the same document, refer to Unit 1, sub-paragraph 1.1.4.  
 To link to an object in another document: 

 Select the Existing file or Web Page option under Link to:, in the Insert Hyperlink 
window.  

 Click the drop-down arrow of the Look in: drop-down list and navigate to the file you 
want to link to. Click on OK. 

 Hover the mouse over the hyperlink to view the file path information. To follow the 
link, press the Ctrl key and click the mouse button. 
 

3.2 Import and export external data 

 Refer to Unit 1, sub-heading 4.2 to: 
 Import data into a spreadsheet using the Text Import Wizard. 
 Import data into a word processing document. 
 Export data to a word processing application. 
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Import data into a database using the Import Text Wizard 

 Open a database. At the Import & Link group, External Data tab, click the Import Text 
File button. 

 At the Get External Data - Text File window, click on the Browse button to specify the 
source of the data.  

 Double click on this file. At the next Get External Data – Text File window, select an 
option to import the file into a new table in the current database, append a copy of the 
records to a table, or link to the data source by creating a linked table.  

 Click OK to open the Import Text Wizard dialogue box. Repeat the steps as for importing 
the data into a spreadsheet.  

 Click Finish and then Close to complete the import process. The text file should appear as 
a new table in your database. 
 

Export data from a spreadsheet as a text file 

 Open the spreadsheet. Click the Save As option from the File tab, to open the Save As 
dialogue box. 

 In the Save as type box, choose Text (Tab delimited), as the text file format.  
 In the Save As box, browse to the location where you want to save the new text file.  
 Click on Save and then OK, to save only the current worksheet to the new file.  
 Click Yes at the dialogue box that appears to save only the worksheet data into the new 

text file. 
 

3.3 Linked objects  

 You use the Paste Special button in the Clipboard group of the Home tab, to paste data 
with a specific formatting.  

 A linked object will be updated whenever the original source is updated. To link an object 
such as a graph: 

o Select Paste Special to open the Paste Special window and then click the Paste 
Link radio button.  

o Select Microsoft Office Excel Chart Object in the As list box, then click OK.  
o To update the graph in the word processing document, right-click the chart and 

select Update Link from the context menu. 
 

3.4 Embedded objects 

 In a word document, in the Text group of the Insert tab, do the following:  
 At the drop-down arrow of the Object button, click on Object.  
 In the Object window that opens, click on the Create New tab.  
 Scroll down in the window, select Microsoft Excel Worksheet. Click OK. 
 Double click on the table in the word document to allow the word processor to load the 

features of the spreadsheet. 
 Click anywhere in the document to exit the edit mode. 
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Question 3 

Make the following changes to the SG_6I file: 
1 Replace the current watermark with a picture watermark saved as SG_6Image. (3) 
2 Use a booklet layout: inside margin 3 cm and outside margin 2 cm.  (3) 
3 Customise the bullets on page 1 with the picture bullet found in SG_6Image.  (3) 
4  Demote the heading 'Qualifications' to one level lower in the hierarchy.   (2) 
5 Change the font colour of all instances of the Heading 2 style to red.  (2) 
6 Insert a blank page at the beginning of the document. Insert an automatic table of contents 

on this page to include only the headings of the Heading 1 style.  (3) 
7 Copy the chart from the Statistics worksheet in the SG_6J file and paste it as an 

updateable linked object on the last page of the word document.  (4) 
8 Save this booklet as a document template with the same name, SG_6I.  (2) 
9 Import the data from the SG_6K file into the SG_6E database file, as a new table that 

contains headings but no primary key. Save the table as Names.  (5) 
10 Insert the data from the SG_6J spreadsheet as an embedded object in a new word 

document. Save this document as SG_6L.  (3) 
  TOTAL MARKS [30] 

 

Answers to Question 3 

 
1 Text watermark removed  and replaced with picture watermark  (SG_6Image)  (3) 

2 Page layout in book fold format  with inside margin 3 cm  and outside margin 2 cm  (3) 

3 Bullets on page 1 replaced  with picture bullets  saved as SG_6Image (3) 

4 The heading ‘Qualifications’ demoted  to one level lower in the document structure   (2) 

5 Heading 2 styles modified to a red font colour  and applied to all 3 instances   (2) 

6 Blank page inserted  showing automatic table of contents  with Heading 1 styles  (3) 

7 Pie chart copied  and pasted as  updateable linked object  on last page  (4) 

8 Document saved as a template file  with the name SG_6I.dotx  (2) 

9 Data imported from SG_6K text file  into SG_6E database as a new table  with first 
row headings  and no primary key. Table saved as Names  

(5) 

10 Data from SG_6J spreadsheet  inserted as embedded object  in SG_6L file  (3) 

TOTAL [30] 
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Chapter 7 HTML/Web design 

Overview 

 

 

 

 

 

 

 

 

 

 

Unit 1 (HTML and HTML tables) focuses on HTML tables and reinforces the concepts of 
websites, web pages, hyperlinks, uniform resource locators (URLs) and the use of hypertext 
markup language (HTML). You will use Notepad++ text editor to create web pages. We will 
also revise Grade 11 HTML syntax and HTML tags.  
 
Unit 2 (Revise HTML and website design) revises website and web page design and reinforces 
other HTML content, concepts and skills: for example HTML syntax, basic HTML tags, 
HTML comments, plain text and text formatting, HTML links, HTML images, HTML lists 
and HTML tables. By the time you get to the end of this chapter you should be very familiar 
with creating HTML tables and be able to develop a web page for a specific scenario. 
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Unit 1 HTML and HTML tables (Term 2) 

1 Revise web and HTML concepts 

Some basic web and HTML concepts that you should know are summarised below.  

1.1 Web concepts 

 A web browser is a software application that lets a user open and display web pages on the 
Internet. Some examples of web browsers are Internet Explorer, Mozilla Firefox, 
Google Chrome, Safari and Opera. 

 A website is a collection of web pages, for example, Kalahari.net is a website and it 
contains many web pages. 

 The World Wide Web (or WWW) contains many websites. Web browsers are able to 
translate web pages because the pages are written in hypertext markup language 
(HTML).  

 A hyperlink is an electronic link in the form of a word, phrase or image that you click on 
to move to a new document or section within the same document. The text or image 
that contains the link is called hypertext or a hotspot. 

 URL stands for uniform resource locator. An URL is the unique address of a website on 
the Internet, for example http://www.education.gov.za. The ‘http’ stands for hypertext 
transfer protocol.  

 You can select View source or View, Page Source to reveal the HTML code for a web 
page. 
 

1.2 HTML concepts 

 HTML stands for hypertext markup language, which is a language that is written in 
computer code so that it can be displayed as a page by a web browser. 

 Markup code is a set of instructions that defines how structured data is presented. 
 Each markup code is called a tag. In HTML, markup tags tell the web browser how to 

display the words and images on a web page. HTML is used to format web pages. The 
web browser does not display the markup tags.  

 Use the file extension ‘.html’ or ‘.htm’ to save a web page.  
 

1.3 Tracking changes 

 An HTML editor is a software application used to create web pages.  
 Text editors such as Notepad or Notepad++ are programs used to write simple text 

documents. Notepad is a free source code editor found in the Microsoft Windows 
operating system and Notepad++ is freely downloadable from the Internet. 

 Tag editors are programs that have a graphical user interface (GUI), but still use HTML 
coding to mark up web pages. 

 WYSIWYG (‘what you see is what you get’) programs are web design tools that allow 
you to drag-and-drop and type the same way you would in a text processor.  
 

1.4 HTML syntax and tags 

 HTML syntax is the way instructions (tags) and text is the structured. 
 HTML tags are often paired so that you have an opening tag and a closing tag. 
 An opening tag is enclosed by a pair of angle brackets, for example <font>. 
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 A closing tag has forward slash (/) in it, for example </font>. 
 Container tags are tags that have both an opening and a closing tag. 
 Tags that have only an opening and no closing tag are called empty tags. 

For example <img src="">. 
 

1.5 Basic document tags 

Summary of the basic document tag and attributes 

Document outline and page information 

Opening tag Closing tag Description 

<html> </html> HTML documents begin and end with html tags, so 
that browsers are able to recognise HTML language.  

<head> </head> Head tag comes after the HTML tag and contains the 
title tag.  

<title> </title> Title tag gives the document a title that displays on 
the browser’s title bar. 

<body> </body> The page content is contained between body tags. 
Body tags contain the text and images of the 
document with all the HTML tags that control and 
format the document. 

Document structure 

<h1> </h1> A heading element includes the heading together 
with the opening and closing tag to show the size or 
level of the heading, for example 1 to 6.  

<p> </p> The paragraph tag makes text between the tags one 
paragraph and forces a new paragraph (similar to 
pressing the Enter key in your word processor); 
creates a double line space. 

<br /> The break tag adds a single line space. It moves the 
text on to the next line. 

<hr /> The horizontal rule tag inserts a horizontal line across 
the page. You can change the colours and width of 
the lines by adding attributes to the horizontal rule 
tag. 

Text formatting and font attributes 

<b> </b> Bold tags make the text font bold.  
<i> </i> Italic tags make the text font italics. 
<font> </font> Font 
<font color="red"> </font> Font colour  
<font size="+8"> </font> Font size (to increase the size) 
<font face="arial"> </font> Font face 
<!-- --> Comment tags allow you to place notes to yourself so 

that you can keep track of elements embedded in 
your web pages. The web browser does not display 
comments. 

Colour attributes 

<body bgcolor="#00ffff">  Sets the background colour for the whole page. 
<body text="#00ffff">  Sets the text colour for the whole page. 
<body link="#00ffff">  Sets the unvisited link colour for the page. 
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Summary of the basic document tag and attributes 

<body vlink="#00ffff">  Sets the visited link colour for the page. 
<body alink="#00ffff">  

 

Sets the activated link colour, which is the colour of 
the link as users click on it, for the page.  

<font color="#ff0000">sample 

text</font>  

Sets the colour of selected text within a page.  

Links 

<a href+""> Page link 
<a href Opening anchor tag 
="http//www.google.com"> URL or address of the document 
This is a link The text on the web page that is clicked on to link 
</a> Closing anchor tag 
Images and image attributes 

<img src> Images can be placed in a web page with the image 
tag <img>. The image is an empty tag and is written as  
<img src=image_URL>  (‘src’ is the source of the 
image, and ‘image_URL’ represents the image file with 
its location. 
If the image is stored on the local hard disk, write the 
code as 
<img src=file///C:xxx.gif>. 
If you store the image in the same folder as the HTML 
files, then you need only write <img src=xxx>. 
 ‘src’ must always be used together with the <img> tag.  

align=left Image will appear to the left of the page, and text on 
that page will wrap around the right-hand side of the 
image. 

align=right Image will appear to the right of the page, and text will 
wrap around the left-hand side of the image. 

align=top Aligns text with the top of the image. 
align=bottom Aligns text with the bottom of the image. By default, 

text is aligned with the bottom of the image. 
align=middle Aligns text with the middle of the image. 
height=200 Controls the height of the image. 
width=220 Controls the width of the image. 
hspace Horizontal space and vertical space: adds white space, 

in pixels, around the image. vspace 

=alt The ‘alt’ attribute can be added to the image tag to give 
alternative text that will be displayed instead of the 
image. 
The ‘alt’ attribute helps users who want to stop the 
images displaying so that page retrieval is quicker. It 
also helps where the browser does not support the 
graphics. 
It can be used to give tool tips by displaying a 
description of the image when the user hovers over the 
image with the mouse. 

border=5 The border attribute of the image tag controls the 
border around an image.  
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Summary of the basic document tag and attributes 

Lists 

<ol> </ol> Ordered list 
<ul> </ul> Unordered list 
<li> </li> List item; you can specify at which number the list must 

start. 
Type=A Upper-case or capital letters, for example A, B, C ... 
Type=a Lower-case or small letters, for example a, b, c ... 
Type=I Upper-case roman numerals, for example I, II,III ... 
Type=i Lower-case roman numerals, for example i, ii, iii ... 
Type=1 Numbers, for example 1, 2, 3 ... 

 
 If you use Notepad++ then you will only need to click on the Run tab and select the web 

browser of your choice, for example Launch in IE for Internet Explorer 3. 
 

2 HTML tables 

 You can present information in HTML using paragraphs and lists.  
 You can display HTML content in rows and columns using tables, with or without 

borders.  
 Most websites use tables to control the layout of each page.  
 HTML tables are used to list and position elements such as text, graphics/images, and 

links on a web page. 
 

2.1 Table elements 

 Specify a table with table opening and closing tags: <table> </table> 
 Specify each row in a table with the opening and closing tags: <tr> </tr> 
 Then specify the actual table cells, which form the columns, with the opening and closing 

tags: <td> </td> (the ‘td’ stands for table data). 
 Here is an example of a simple table: 

 
HTML coding Web page display  

in web browser 

<table> 

  <tr> 

    <td>Table with no border 

attribute</td> 

  </tr> 

</table> 
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2.2 Table element with a border attribute 

You need to specify a border attribute if you want to see the border.  
 Here is an example: border="1">. 

 

HTML coding Web page display  

in web browser 

<table border="1"> 

  <tr> 

    <td>Place text in a table border</td> 

  </tr> 

</table> 

 

 

2.3 Table elements: columns 

 Follow a similar process to set up a table with two columns.  
 Specify the table cell again (<td> and </td>) and the tags between the opening and closing 

table rows (<tr> and </tr>). For example: 
 

 

2.4 Table elements: rows 

 A table with one column and two rows will be specified with:  
 the opening table row tag <tr>,  
 then the opening table data tag <td>,  
 and the text to appear in that cell. 

 Insert the closing table data tag </td>, and the closing table row tag </tr>. 
 Repeat this process to create another row. 
 

HTML coding Web page display  

in web browser 

<table border="1"> 

  <tr> 

    <td>1st column </td> 

    <td>2nd column </td> 

  </tr> 

</table> 

 

HTML coding Web page display  

in web browser 

<table border="1"> 

  <tr> 

    <td>row 1</td> 

  </tr> 

  <tr> 

    <td>row 2</td> 

  </tr> 

</table> 
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2.5 Tables with captions and table heading elements 

 A table caption adds a label to a table.  
 The caption should give the viewer some idea what the table is about.  
 Caption tags are defined as <caption> and </caption>. 
 Headings are added to rows or columns with the table heading tags: <th> and </th>.  
 Browsers usually centre the contents of a <th> cell and display any text in the cell in bold 

font.  
 

2.6 Tables with empty cells 

 If you want an empty cell (a cell with nothing in it) define the <th> or </td> element with 
nothing inside it. 

 If you want to see the empty cell then add a break tag. 
 Make an outline of your table so that you can see the headings and the value of each cell. 
 Use your word processing application or spreadsheet to type up the table quickly.  

 

3 Table appearance attributes 

 Use table attributes to change the look or appearance of your tables.  
 You can change: 

 the width of the tables and cells 
 the amount of spacing between cell content and rows and columns 
 the width of the borders. 

 
3.1 Table width 

 You can control the width of the table using the width attribute, <width>.  
 You can set the width value in pixels or specify it as a percentage.  
 To make a table as wide as the browser window, you specify the width attribute as 100%, 

for example: <table border="1" width="100%"> 
 

3.2 Table borders 

 Border widths are specified in pixels.  
 You can change the size of the border by selecting your own number value.  
 Use a border size of 0 if you want a table with no border.  
 Sometimes, it is useful to use borderless tables to structure the layout of your web page. 

 
3.3 Cell padding attribute 

 Use the cell padding attribute to set the amount of space to be displayed between the cell 
edge and the cell content.  

 By default, many browsers use a cell padding of 2 pixels.  
 Set the space in pixel values by adding the cellpadding attribute to the <table> element.  
 If the cell padding attribute is 0, the cell borders will touch the edges of a cell’s contents. 

For example: 
  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 100 

HTML coding Web page display in web 

browser 

<table border="3" cellpadding="10"> 

  <tr> 

    <td> cell 1 </td> 

    <td> cell 2 </td> 

  </tr> 

</table> 

 

 
3.4 Cell spacing attribute 

 Cell spacing is the amount of space between the cells.  
 Cell spacing is the width of the space between the inner and outer lines of the table border.  
 By default, cell spacing is 2 pixels wide.  
 Cell spacing also includes the outline around the table, which is just inside the table’s 

border (as set by the border attribute).  
 In the following coding, the table has a cell spacing of 8. 

 

 
3.5 Column width attribute 

 You can apply the width attribute to individual cells to specify the width of columns in a 
table, for example in the table heading cell <th> or in the table data cell <td>.  

 You can use exact pixels or a percentage.  
 The percentage is a percentage of the full table width.  

 
3.6 Colour attribute 

 You can add background colour to a table, row, cell or border in Internet Explorer.  
 You change the colour of a border by changing the colour value using the border colour 

attribute: border colour. 
 

3.7 Background images in tables, rows and columns 

 Add background images to tables, rows and columns using the background attribute. 
 

  

HTML coding Web page display  

in web browser 

<table border="3" cellpadding="10" 

cellspacing="8"> 

  <tr> 

    <td> cell 1 </td> 

    <td> cell 2 </td> 

  </tr> 

</table> 
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3.8 Alignment 

 The align attribute aligns content horizontally.  
 The valign attribute aligns content vertically.  
 By default, tables are displayed on a line by themselves along the left side of the page, 

with any text appearing above or below the table.  
 You can use align="left" to align the table along the left margin with all the text wrapping 

around the right side of the table.  
 To do the opposite, use align="right". 
 As with images, you can use the line break element with the clear attribute to stop 

wrapping text alongside the image.  
 To centre a table you can use the <center> or <div align="center"> element.  
 You can also align data within each cell horizontally or vertically. 

 
3.9 Row and column span 

 You can create cells that stretch over multiple rows or columns within a table.  
 To create a cell that stretches over (spans) multiple rows, you add the rowspan attribute to 

the <th> or <td> elements, together with the number of rows you want the cell to span.  
 To create a cell that spans multiple columns, you add the colspan attribute to the <th> or 

<td> elements, together with the number of columns you want the cell to span.  
 The data within that cell then fills the width or length of the combined cells. 

  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 102 

Unit 2 Revise HTML and website design 

(Term 3) 

Good website and web page design 

 The time a viewer spends on a website will depend on: 
 what the viewer wants to get from the website 
 the other websites the viewer wants to look at 
 how important it is for the viewer to get the information or product he or she is 

looking for. 
 When you design a website, make every part of the site meaningful and helpful. 
 It is important that you lay out the images and text on your website attractively. 

 
Guide the viewer’s eye and keep his/her attention 

 Plan your design using the ideas below: 
 The placement or position of items on the page will have an effect on the order in 

which the viewer looks at the items. 
 The size of something will get the viewer’s attention. Big lettering and big images 

stand out. 
 The way colours are used will tell a viewer where to look.  
 Use contrast to make things stand out, for example white text on a black background.  
 Use Design elements, for example use an arrow to point to something in order make 

the viewer look in that direction. 
 

Proximity and spacing 

 Proximity refers to distance between elements on a web page, that is, how far apart or 
close together they are.  

 Here are some spacing ideas: 
 Line spacing: The space between the lines can make your web page easier to read. 
 Padding: Padding is the space between the elements and the text.  
 White space: White space (also called empty space) is used to give order and contrast 

to a page. 
 

Navigation 

 Help visitors to your website by adding navigation buttons that are well labelled.  
 You can also add links to guide a viewer from one part to the next. 

 
Typography 

 Typography is the way in which typeface or text is used in the design of a website.  
 Text is one of the most common elements of a design so it is important to think about how 

you will display it. 
 Font styles can say a lot about the design. Choose a font style that matches the kind of web 

page you are designing. 
 Choose the correct font sizes to make your web page easy to read.  
 Main headings will have a bigger font size than subheadings.  
 Keep the length of your lines of text short.  
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 Columns of text often work well. (Use the layout of a newspaper as a guide.)  
 Long sentences are difficult to read, so keep your sentences under 16 words. 
 Plan your paragraphs and alignment.  
 Decide what text and how much text you want in each paragraph.  
 Left justification works well in most cases. 
 Choose your font colours to match the message of your website.  

 

Questions 

1 What is a website?  (1) 
2 Discuss three features of ‘good’ website design.  (3) 
3 List two of the most common formats for saving images in, especially for the use in 

HTML.   (2) 
4 What kind of HTML list is used to create a numbered list?   (1) 
5 Why are tables used in HTML?  (1) 

TOTAL MARKS [8] 

 

Answers 

1 A website is a collection of web pages.  

. 

(1) 

2 Good website or web page design will:  

 have a neat design, pleasing colours and fonts  

 have correct and interesting content   

 have links that work  

 credit the work of authors and others   

 be updated regularly  (Any three) 

(3) 

3 ‘.gif’ and ‘.jpeg’ format (2) 

4 ordered list  (1) 

5 Tables are often used to structure the layout of a website.  (1) 

  TOTAL [8] 
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Chapter 8 Information management and 

PAT 

Overview 

 

Information management requires you to access, process, analyse and evaluate data to solve a 
problem or make a recommendation. 
 
Unit 1 (Managing and gathering information) reinforces concepts and skills of information 
management to prepare you for the Practical Assessment Task (PAT). You will define what 
you are required to do; prepare questions to find the information you need; set questionnaires; 
find sources of quality information; gather and use different but suitable data and information 
to prepare a formal report in a word processing application. 
 
Unit 2 (Process and analyse information) requires you to handle and evaluate the data you 
have found, and how to work with it to extract useful information. You will use spreadsheets 
and databases to help you process the data and identify patterns in it.  
 
Unit 3 (Present information) deals with steps to complete the final phase of the PAT. You will 
use your information to solve a given problem. You will finish a formal and professional-
looking report in a word processing application and prepare a presentation on your findings. 
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Unit 1 Managing and gathering information 

(Term 1) 

1 Concepts and skills from Grade 10 and 11 

1.1 Information management concepts 

 Managing information involves gathering, selecting, organising and interpreting data, and 
presenting processed data as information.  

 The PAT for Computer Applications Technology describes a topic that you need to 
research. The task will be given to you as a scenario for a task to be completed, and a 
problem to be solved.  

 The PAT consists of phases where you need to demonstrate:  
 Data gathering skills and techniques 
 Data manipulation skills 
 The ability to produce quality output using computer application skills. 

 
1.1.1 Gather data 

 Gathering data starts with understanding why you want the data.  
 Start by asking questions that identify the problems linked to the topic that you have been 

given.  
 You need to ask questions because the answers will help you define the problem and work 

out what data you must find.  
 Identify different sources of data and information.  
 You will have to design a questionnaire as one of your sources of data.  
 You will use the questionnaire to get answers from a sample of people.  
 You will also have to find and evaluate information from the Internet. 

 
1.1.2 Select, organise and interpret information 

 Once you have collected data, you will need to process it to make it meaningful. 
 Use your spreadsheet skills to process and analyse the data you gather from the 

questionnaire to show trends and patterns.  
 

1.1.3 Present information 

 The final presentation of the information will be: 
 A formal report prepared in a word processing application (outline the problem and 

recommend a course of action or plan to solve that problem) 
 A summary in the form of a presentation such as a web page. 
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1.2 Task definition and data gathering 
 Before attempting any project, you must understand what is expected of you.  
 Follow the PAT instructions carefully, then write a task definition in your own words.  
 A task definition specifies the problem you have to solve, who wants you to do this work, 

what information you need to find, and how and where you will find the information. 
 You need to answer questions such as these: 

 Why are you doing the investigation? 
 What are the main tasks that you need to carry out? 
 How will you go about it? 
 What information do you need? 
 What do you know about the topic or problem? 
 Where and how can you find information you still need? 
 Who wants the information? 
 How must you present the information? 
 By when must the task be completed? 

 Plan and create a set of electronic folders to store the information.  
 

1.2.1 Identify problems associated with the topic 

 After defining the task and selecting possible headings, ask questions that will guide your 
research and your report writing.  

 Here are some ideas: 
 Questions that lead to factual information: level 1 questions usually starting with 

words such as ‘What’, ‘When’, ‘Where’, ‘Who’ or ‘How many’. 
 Questions that explore: level 2 questions starting with ‘Why’ or ‘How’. 
 Questions that predict: level 3 questions starting with ‘If’ or ‘What if’. 
 Questions that help make judgments: level 4 questions that help you reach a 

conclusion, that start with phrases such as ‘Would it be better if’, ‘How can I 
determine’ or ‘What would be the best way’.  

 When you have your list of questions, arrange them according to the headings you have 
identified for the main parts of the topic.  

 You may want to add new headings or remove some you no longer want.  
 

1.2.2 Find possible sources of information 

 After the task definition, you will need to find information.  
 Different sources you can use are: 

 Publications: Books, newspaper articles, magazines and brochures. 
 Electronic media: The Internet, including encyclopaedias and social networks. 
 Interviews: Prepare a set of questions. 
 Surveys: These useful tools help you find out more about people’s attitudes and 

circumstances. You will need a questionnaire with questions that respondents can 
complete in a short time.  

  



© Copyright Via Afrika Publishers, Computer Applications Technology Grade 12 107 

2 Setting questionnaires 

 A questionnaire is a set of questions that have a choice of answers.  
 People use questionnaires to get data or information for a survey or research task 
 Information gathered using a questionnaire is called primary data. 
 When you design a questionnaire, ask closed or yes/no type questions, if you can.  

Remember the following: 
 Keep the questions short and simple, direct and easy to understand. 
 Each question should focus on only one point at a time. 
 Make sure that people are able to give unplanned answers. 
 When you get a yes/no answer, you may want to ask your respondent ‘Why’. 
 Ask the question in such a way that you do not guide people to the answer. 
 Arrange your questions from fact-type questions to opinion-type questions, from least 

sensitive to most sensitive, from general to specific. 
 Get someone else to check your questions to see whether he or she interprets them the 

way you intended. 
 Keep the final questionnaire short. 
 Ask someone else if you can ‘practise’ the questionnaire on them. 

 
2.1 A closed questionnaire 

A closed questionnaire usually has questions with only one or other answer, for example ‘Yes’ 
or ‘No’. 
 
2.2 A quantitative questionnaire 

A quantitative questionnaire has questions that measure the quantity of something, for 
example how strongly people agree or disagree with a statement.  

 
2.3 A qualitative questionnaire 

A qualitative questionnaire has questions that will give you ‘exact’ responses to your 
questions. 

3 Gathering information 

Think of ways to find the information you need for your investigation. 
 
3.1 Quality control techniques 

 Not all information is reliable.  
 Check these aspects: 

 Authority – who created the information? 
 Accuracy – can the statements and claims be substantiated? 
 Currency – is the information up to date, and is it still relevant? 
 Objectivity – does the source/author show any bias? 
 Coverage – how well does the information cover the topic? 
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3.1.1 Evaluate websites 

 Use the following criteria to help to assess the reliability of a website: 
 Affiliation – who supports the website? 
 Authority/the author – who created the website and what are the author’s credentials?  
 Content – is the content properly organised? Do the links work? 
 Current – is the information on the web page up to date and still suitable? 
 Design – is it easy to navigate and is it visually pleasing? 
 Objectivity – does it reflect any preconceptions? 
 Trustworthy – Would you be able to use it? 

 
3.1.2 Sift information 

Go through the available information and select the most relevant websites and other 
information sources.  

4 Write a formal report 

 A report is a document that gives information about an investigation or research done. It 
should include analysis, evaluations and recommendations. 

 When writing a report, you should: 
 Analyse the information you were given. 
 Find more information by reading books, visiting websites and consulting other 

sources relevant to the investigation. 
 Draw conclusions from the facts presented. 
 Give general trends or patterns. 
 Make recommendations, persuade or give an opinion. 
 End with a conclusion. 

 The structure of a report is usually as follows: 
 Title page: Topic of the report, author’s name and date of writing the report. 
 Table of Contents  
 Introduction: Outline the task definition and the reason for the investigation. 
 Body paragraphs: Use main headings and subheadings to organise the themes. 
 Recommendations or findings: Say how the problem may be solved or how the 

situation may be improved.  
 Conclusion: Draw all the main points together to present an overview. 
 Bibliography or list of references: use the Harvard or APA (American Psychological 

Association) method. 

5 Spreadsheets and databases in formal reports 

 After gathering your data and information, organise and interpret the data you have 
collected.  

 Spreadsheets and databases will help you process the responses from the questionnaire.  
 You can create graphs in spreadsheets to show trends and patterns.  
 You can also record the responses to your questionnaire in a database and then generate 

queries and reports to place in your formal written report. 
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Unit 2 Process and analyse information  

(Term 2) 

1 Recap information management skills 

 The PAT involves gathering data and information by asking questions.  
 Use different types of questionnaire (closed, qualitative and quantitative) or a combination 

to obtain information from respondents.  
 Check the authority, accuracy, currency, objectivity and coverage of the information.  
 A formal report is an organised document. It outlines a problem statement, shows the 

relevant sources, describes your conclusions, gives general trends and patterns, 
describes your recommendations and contains a conclusion.  

 It has a cover page, table of contents, introduction, body, findings or recommendations, 
conclusion, and finally a bibliography where you acknowledge your references. 

2 Spreadsheets and databases in formal reports 

2.1 Process data: spreadsheets and databases 

 Study the data and identify the relationships between them.  
 The information in your report must show your audience how your proposals will improve 

matters and solve the problems. 
 

2.1.1 Process data using a spreadsheet 

 The first stage in manipulating data is to get it sorted and grouped.  
 Spreadsheets help you to: 

 Analyse data and use calculations to extract meaningful information. 
 Summarise the information and add your own insights. 
 Use formatting features such as borders, word wrap and font styles. 
 Create charts and tables to make the material more understandable. 

 The questionnaire results are analysed in a spreadsheet.  
 Ask questions such as: How many? What occurs most often? What is the most popular? 

What is least common? How many more than? What is the average? 
 Use spreadsheet functions such as COUNT and IF functions, such as COUNTA, 

COUNTIF, IF and SUMIF.  
 Other functions are CONCATENATE, LOOKUP, AND, NOT, MIN, MAX and 

AVERAGE.  
 

2.1.2 Process data using a database 

 Create a database with the information you have gathered so that you can generate queries 
and provide database reports.  

 Use suitable field names and data types.  
 Use the information from your database queries and reports in your word processing 

report, and the slide show or web page. 
 

2.2 Practical application of skills and concepts 

 Use spreadsheet formulas and functions and prepare a chart from the statistics. 
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Unit 3 Present information (Term 3) 

In the last phase of the PAT, you bring all your findings and supporting documents together in 
a report) and a presentation.  

1 Practical Assessment Task: Final phase 

The final phase of the PAT is to present your work to your target audience.  
 
1.1 Create a presentation or web page 

 The slide presentation or web page that you must create for the PAT covers the same 
information you covered in your report.  

 However, the presentation or web page deals with the information much more briefly than 
the report does. 

 Select only the main points. 
 

1.1.1 Declaration of authenticity 

 Hand in a declaration of authenticity to confirm that this is your work and that you have 
not plagiarised any points included in your presentation. 

 Before you hand in your work, check everything. 
 Proofread your work carefully. 
 Correct any spelling and grammar errors. 
 Check the visual appeal of your documents, including the layout, font styles, colours, 

pictures and charts. 
 Check that you have acknowledged all sources correctly. 

 
1.1.2 Copyright and plagiarism 

 Acknowledge the source of information that you have used from others. 
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Questions 

1 What does 'managing information' entail?  (2) 
2 Why is it necessary to write a task definition when doing the PAT?  (2) 
3 List two aspects you will write in a task definition.   (2) 
4 Name two sources of information that you could use when doing the PAT. (2) 
5 List two criteria would you use when evaluating information?  (2) 

TOTAL [10] 

 

Answers 

 
1 Managing information:  

gather  

select, organise and interpret information  

and present that information   

(3) 

2 Reason for task definition:  

demonstrate that you are familiar with what you need to do  

guide you in your research and planning   

(2) 

3 Task definition: 

use your own words to describe what you have to do  

what you already know about the topic  

what information you need to find  

where and how you will find that information     (any two) 

(2) 

4 Sources of information:  

publications  

electronic media  

people: interviews and surveys      (any two) 

(2) 

5 Evaluate information:  

Check the:  
authority  
accuracy  

currency  

objectivity 

coverage of the source or website      (any two) 

(2) 

TOTAL [10] 

 




